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Rendering by Eridia Studio | Jean-Christophe Erny
 
NVIDIA® Iray® is the first GPU-accelerated solution for physics-based, photo-realistic rendering world-wide.
Combined with the parallel processing power of the latest NVIDIA® video processors, Iray achieves interactivity
with extremely fast reactions and significantly accelerates the iterations required to create perfect scenes.
 
Autodesk® Maya® 3D animation software offers a comprehensive creative feature set for 3D computer
animation, modeling, simulation, rendering, and compositing on a highly extensible production platform.
 
Iray for Maya 2.2 is developed by [0x1] Software and Consulting GmbH (www.0x1-software.com). [0x1] integrates
Iray as an independently available renderer in Maya. It enables the user to take advantage of Iray's interactivity
combined with its physically plausible rendering capabilities in computer graphics production.
 
[0x1] endeavors to integrate Iray as seamless as possible into Maya. Nevertheless, at some points the different
philosophies of the two software packages have made it necessary to implement workflow strategies in new ways
not found by users in the original packages.

2 Iray principles
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The performance of a renderer such as Iray is relatively independent of how complex the scene geometry is. The
complexity of light paths is more important: A candle in a labyrinth, or light rays diverging from a narrow window,
will take longer to yield a good-quality rendering than light shining through a broad skylight or picture windows.
As with other renderers, performance is also proportional to the resolution of the rendered image. The complexity
of materials in the scene also affects performance: The more textures, blending, and noise a material has, the
longer it takes to calculate the results.
 
Iray is physically based and simulates light paths as close as possible to reality. This is the reason why you have
to act in specific situations different than in other renderers like mental ray. To give an example: It is not possible
to turn off shadows for specific geometry.
 
Iray for Maya 2.2 offers two render modes: Iray Photoreal and Iray Interactive. Iray Photoreal is exactly the render
mode users are familiar with from older Iray for Maya versions. It is an interactive, ray-tracing based render mode
that generates "push-button" photorealistic imagery featuring complex global illumination effects. Iray Photoreal
makes use of a highly optimized BSDF and EDF based framework, essentially capturing the physical behaviour
of real-world materials and light sources. Iray Photoreal can leverage NVIDIA CUDA capable GPUs to render
photorealistic images much faster than on a CPU, due to the highly parallel nature of the underlying simulation
processes. If a system does not feature CUDA capable graphics boards it will automatically fall back to using only
CPU based rendering. This will produce the same images but typically the rendering will take longer to complete.
In addition, it can also use both resources at the same time.
 
Iray Interactive is an interactive raytracing render mode which uses faster yet less accurate rendering algorithms
than Iray Photoreal. Iray Interactive targets a look which is consistent with the physically based result of Iray
Photoreal, yet it is optimized for interactive scene manipulations. Iray Interactive leverages NVIDIA CUDA-
capable GPUs. It is ideal where ray-tracing effects, such as reflections and refraction, are desired and limited
photorealism is acceptable.

3 Physically-based scene setup with Iray
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 Rendering by Lee Henshall
 
Setting up a scene for physically-based rendering in Maya isn't that much different than setting up a scene for
any other renderer. Anyhow there are some work flow issues to consider. This topic tries to give an introduction to
some topics. It doesn't claim to cover everything but hopefully will give some useful hints.
 
Beside the way how specific objects should be modelled to create correct results for glass or embedded volumes
it is necessary to understand some major differences to traditional render approaches. First off all you must
be aware that Iray Photoreal always renders every lighting effect like direct illumination, indirect illumination,
caustics, etc. There is no additional set up necessary. The only limiting factor here is the attribute Max. Path
Length in the Render Settings window. See the chapter “Render Settings” for details.

3.1 Lights
 

Physically based rendering claims to simulate reality as close as possible. In the real world every light emitter has
a size and shape. Traditional light models in computer graphic like directional, point or spot light doesn't have this
restriction and will be represented by icons. Light is coming out of one point in space.
 
The idea in Iray Photoreal is to use the image based lighting approach by using the nodes
ifmImageBasedLighting or ifmHosekSkylight or modeling the shape of the light emitter and combine it with one
of the light emissive materials available. To get a proper result when using physically based rendering the correct
modelling of light emitting shapes is necessary. The closer the model fits to the real light the better the simulation.
But in many situations this approach isn't required to get photorealistic and more important, great looking results.
So it is legitimate to decrease the complexity of light emitting geometry as long as the result fits to the aimed look
in the final rendering.
 
To get an idea how to simulate traditional light models in Iray Photoreal the following set up can be used. This
gives an idea how to use the given tools to get the expected results while lighting a scene.
 
Direction light
Use an ifmHosekSkylight and turn the attribute Sky off. Set the attribute Azimuth to 90 and the attribute
Saturation to 0. The attribute Ground Albedo should be set to black (R=0, B=0, G=0). Rotating the
ifmHosekSkylight gives a similar result as using a Directional Light in Maya.
 
Point light
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Create a polygon sphere, scale it down and assign an ifmOmniEmitter to it. Keep in mind that you might need to
adjust the attribute Exponential Intensity to see any results.
 
Spot light
Create a planar polygon, scale it down and assign a ifmSpotEmitter to it. Keep in mind that you might need to
adjust the attribute Exponential Intensity to see any results.
 
Note: Since Iray for Maya 1.2 the standard Maya lights are supported.
 
Light linking and shadows
Because in the real world every light creates a shadow and every objects casts and receives a shadow, light
linking or object-specific shadow calculation in Iray is not possible.
 

3.2 Modeling glass
 

In real life, glass objects always have a thickness. Even when really thin, their depth is often not inconsiderable.
In order to compute proper refractions, Iray expects light rays to travel through solid geometry.
 
In some cases, the thickness really is negligible. Examples are far-away windows or soap bubbles, cases
where refraction effects are no longer visible. In such cases, modeling objects without a thickness is fine, if the
materials are set up accordingly. The thin-walled feature of MDL is designed for just this purpose. Remember that
refractions will be ignored with this setting enabled.
 

Thin-walled glass material
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Glass material on a solid geometry
 

Iray will be able to properly compute and render refractions when glass is modeled as a solid geometry. The following example illustrates
how important it is to model glass geometries in the exact same way as they appear in real life in order to get an accurate result with Iray.
 

 
Light bulb modeled with a single continuous line. Once the curve is revolved in Maya, the result will be a solid geometry. When rendered
with a physical glass material, the bulb will look like its one solid piece of glass.
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To model a realistic bulb, ensure that the hull is one thin layer of glass that always has a thickness. Model a very thin external layer. Note
the drastic difference between the solid light bulb above and this version which uses a modelled hull.
 
 
 

3.3 Modeling volumes
 

This chapter provides recommendations about modeling neighbouring volumes and enclosed volumes. When
modeling neighbouring volumes such as liquids in basins or different layers of liquids, you can handle this
situation in two different ways:
 

•  Separate them with a thin layer of air, which will cause additional refraction effects
•  Slightly overlap them to get realistic refraction effects
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This image shows non-overlapping volumes. The layer of air that separates them causes non-realistic refraction effects.
 

This image shows overlapping volumes, which shows the physically correct variant.
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Note: When rendering with Iray, a slight overlap is the recommended modeling technique for
neighbouring volumes.
 
When modeling enclosed volumes, no special modeling guidelines need to be considered to ensure correct
rendering results. The following line drawing provides a simple example - a glass of water with ice cubes that
contain air bubbles.
 

Ice cubes in the water scene setup
 

Ice cubes in the water render correctly with non-overlapping volumes. When modeling the air bubbles, the ice
cubes and the water, it is not necessary that these overlap as the air bubbles are enclosed by the ice cubes,
which are again enclosed by the water. The glass and the water are neighbouring volumes however, so they
should be modeled with a slight overlap.

3.4 Mapping UV-coordinates for anisotropy
 

Uv-coordinates are used to define how a texture is mapped on to some geometry. However, UV-coordinates are
also used when you have a surface with anisotropic reflections. The layout of the UV-coordinates defines the
direction of the reflections on the surface. Just imagine it as the brush direction in case of brushed metal. Ensure
that the UV-coordinates are well placed for anisotropic reflections. The orientation of the mapping effects the
orientation of the anisotropic reflection.
 

Anisotropic material on an object with planar uv-mapping.
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Anisotropic material on an object with spherical uv-mapping.

3.5 Recommendations for material settings
 

The following tips can help you to provide physically plausible material settings for Iray and benefit from
photorealistic results with less noise and faster rendering times.
 
Don't use pure white colors. Pure white materials are rarely found in nature. They should be avoided. Avoid
diffuse color values such as RGB=[1,1,1] (pure white), which could, for example, be replaced with [0.7, 0.7, 0.7]
for white paper. Only few materials, such as pure snow, can reach values as high as 0.9.
 

Pure white (left) compared with physically realistic white (right)
 
Don't use pure black colors: Purely black surfaces are rarely found in nature. They should be avoided as such.
An RGB value like [0,0,0] could for example be replaced with the value [0.04, 0.04, 0.04] for charcoal or fresh
asphalt.
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Pure black (left) compared with physically realistic black (right)
 
Avoid perfectly reflective materials when possible. In nature, a reflectivity ratio of 0.7 is already considered high.
Set reflectivity to [0.7, 0.7, 0.7] instead of pure white. Freshly polished silver or chrome can reach reflectivities
above 0.9, but oxidation and dust reduces this already.
 

Perfect reflectivity (left) compared with realistic reflectivity (right)
 
Decide if emitting objects have to also reflect light. In most cases, this will not be necessary and materials without
any BSDFs are cheaper to compute. If you do need a full material, use the ifmAddEmission material Tool and
test material settings plugged in to Surface attribute first before adding emission. Otherwise, the brightness of the
emission will make it hard to spot problems with the material setup.
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Improperly set up glowing material (left) compared to properly set up glowing material (right)
 
Alpha maps embedded in textures are not used to automatically create holes. Use the cutout opacity of the
ifmGeometryModifier material tool to create holes in objects.
 

ifmGeometryModifier Cutout Opacity attribute used to create holes in objects.
 
 

4 IFM Control Box
The IFM Control Box is a user interface to grant fast feedback to the Iray specific Rendering Editors. Also it gives
quick access to the different canvases and enables a quick preview for gamma and exposure settings. In addition
it gives the user the choice to select between local and cloud rendering.
 
By default the IFM Control Box appears in the same place where the Channel Box is located. It can be torn off
like any other Maya panel.
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IFM Control Box icon in the Status Line
 
To get fast access to the IFM Control Box the IFM icon in the upper right corner of the Maya window can be used.
This icon is part of Maya's Status Line, so make sure that this UI element is visible.
 
Note: The settings in the IFM Control Box do not affect the result of the rendered image.
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 IFM Control Box
 
 
 

4.1 Iray for Maya Rendering Editors
 

Rendering editors
 

 
Logging Manager
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Click this button to open the Logging Manager. This action is a shortcut for choosing Window ➤
Rendering Editors ➤ Iray Photoreal ➤ Logging Manager. For more information, see the chapter
“Rendering editors.”

 
Queue Manager

 Click this button to open the Queue Manager to send files to Iray Server or Quadro VCA. For more
information, see the chapter “Rendering editors.”

 
Resource Manager

Click this button to open the Logging Manager. This action is a shortcut for choosing Window ➤
Rendering Editors ➤ Iray Photoreal ➤ Resource Manager. For more information, see the chapter
“Rendering editors.”
 

Streaming Manager
Click this button to open the Streaming Manager. This action is a shortcut for choosing Window ➤
Rendering Editors ➤ Iray Photoreal ➤ Streaming Manager. For more information, see the chapter
“Rendering editors.”

4.2 Render view attributes
 

Render view attributes
 
Canvas

Displays the selected framebuffer if it is selected in the Render Setting window Output ➤ Color Canvas
 
Stereo

When using the Stereo output attribute in the camera shape Attribute Editor this attribute defines if the left
or right camera view is shown in Maya's Render View.

 
Note: Maya's Render View can't display side-by-side or top-down images. Also the Render
View is not able to show multi-view OpenEXR images. The Stereo attribute in the IFM
Control Box is the only way inside Maya to check how the view from the left and the right
camera will look like.

 
Exposure

Defines the exposure of the overall image. This attribute has no effect to the output image.
 
Gamma
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The gamma parameter applies a display gamma correction. This attribute has no effect to the output
image.

 
Note: Since Maya 2015, the Render View window allows to control Exposure and Gamma
as well. Setting the attributes in the Render View and in the IFM Control Box doubles any
effect. Make sure that you use either one or the other.

 
Min. Depth

The depth image is a 32-bit image. Max. Depth maps the color black to the distance set in this attribute.
This attribute has only effect when in the Render Settings window Output ➤ Other Canvas ➤ Depth is
activated.

 
Max. Depth

The depth image is a 32-bit image. Max. Depth maps the color white to the distance set in this attribute.
This attribute has only effect when in the Render Settings window Output ➤ Other Canvas ➤ Depth is
activated.

 
Min. Distance

The distance image is a 32-bit image. Max. Distance maps the color black to the distance set in this
attribute. This attribute has only effect when in the Render Settings window Output ➤ Other Canvas ➤
Distance is activated.

 
Max. Distance

The distance image is a 32-bit image. Max. Distance maps the color white to the distance set in this
attribute. This attribute has only effect when in the Render Settings window Output ➤ Other Canvas ➤
Distance is activated.

4.3 Swatch Rendering
 

Render view attributes
 

The Swatch Rendering section in the IFM Control Box creates individual swatches in the Hypergraph illustrating
the actual settings of the corresponding material. This allows the user to create an individual appearance of the
swatches in the Hypergraph.
 
Mode Static

When the Static mode is set no updates in the Hypergraph swatches will be rendered. This is the default
behaviour.

 
Mode Dynamic

When the Dynamic mode is set Iray renders an individual swatch corresponding to the attribute settings
of the selected material.

 
Samples

Defines the number of samples for the swatch rendering.
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Note: The Samples attribute is only valid when Mode is set to Dynamic.

 
Post Denoiser

Enables the Post Denoiser for the swatch rendering.
 
Note: The Post Denoiser attribute is only valid when Mode is set to Dynamic.

 
Refresh all swatches

Clicking this button triggers an update for all swatches in the HyperShade.
 
Note: When the attribute Mode is set to Static and Refresh all swatches will be triggered
all swatches are reset to the default appearance of the HyperShade swatches.

4.4 Render mode control attributes
 
 

Render Mode Local
Select Local to use the local render resources on your workstation. You can specify the used render
resources in the Local tab in the Resource Manager. For more information, see the section “Iray
Resource Manager.”
 

Control attributes for local render mode
 

Render Mode Cloud
Select Cloud to use a Quadro VCA or Iray Server for rendering. You must specify a network connection in
the Cloud tab in the Resource Manager. For more information, see the section “Iray Resource Manager.”
 

Control attributes for cloud render mode
 

Format
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Select Format to define how the rendered images will be streamed in Maya's Render View window. The
default setting is video, which means H.264 video coding. You can also choose .jpg, .png or .exr format.
The setting video delivers the best performance. JPG, PNG, and EXR increase quality but may slow
down the interactive performance in the Render View.

 
Framerate

Defines the frame rate per second. The default value is 5, which means that the maximum speed will
be 5 frames per second. Increasing this value may increase performance but decrease quality. Use this
attribute with care.

 
Bitrate Min

This is the minimum bit rate Iray Server will use when encoding the video stream.
 
Bitrate Max

This is the maximum bit rate Iray Server will use when encoding the video stream.
 
Iray Server or a Quadro VCA will automatically adjust the actual bit rate for the video stream depending on
the estimated available bandwidth of the connection, but only within the span of the configured minimum and
maximum bit rate. Setting the minimum and maximum bit rate to the same value will force Iray Server or a
Quadro VCA to use that bit rate regardless of the available bandwidth. If less bandwidth is available than the
minimum bit rate setting then Iray Server or a Quadro VCA will automatically lower the frame rate to compensate.
Iray Server will never use more than the maximum bit rate setting, even if this is lower than the configured
minimum bit rate.

5 Rendering Editors
 

In the Maya main menu Window ➤ Rendering Editors you find a menu named Iray. This menu contains the
necessary Rendering Editors for Iray for Maya 2.2.
 
The Rendering Editors can also be accessed using the IFM Control Box.

5.1 Iray Resource Manager
 

The Iray Resource Manager gives control over the local render resources or gives access to cloud rendering
using a Quadro VCA. It has two tabs: Local and Cloud. The settings in the Iray Resource Manager is stored
independent from the Maya scene file.
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Iray Resource Manager
 
Note: The Iray Resource Manager controls which render resource or which Quadro VCA will be
used while rendering. The final decision to use local or cloud rendering will be done in the IFM
Control Box.

5.1.1  Iray Resource Manager for local rendering
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Resource Manager to set up the local render resourves
 

When choosing the Local tab the Iray Resource Manager shows a list of all detected CPUs and NVIDIA graphic
cards that are found by Iray and will be used for rendering. By default all devices are enabled.
 
If a specific render resource has no check mark it won't be used by Iray. This makes sense, for example, if you
want to save performance for the user interface.
 
Note: You must enable at least one render resource to work with Iray.

5.1.2 Iray Resource Manager for cloud rendering (Quadro VCA)
 

When choosing the Cloud tab the Iray Resource Manager provides a user interface to connect to a Quadro
VCA or to Iray Server. Cloud Rendering let Iray for Maya 2.2 render on a computer that is connected via Internet
or local network into Mayas Render View. Your local resource are not used by Iray for Maya 2.2 when Cloud
Rendering is selected.
 
Note: When a connection to a Quadro VCA is established, Iray does not necessarily start
rendering on the Quadro VCA. The final decision to use local or cloud rendering is done in the
IFM Control Box.
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Iray Resource Manager to set up the cloud rendering using Quadro VCA.
 

Type
You can choose to connect to a Quadro VCA or to Iray Server. To use a Quadro VCA, choose VCA.

 
Server Address

Type a valid server address to connect to a Quadro VCA. If you are not sure what the correct address is,
ask your system administrator or read the Quadro VCA manual.

 
Server Port

Quadro VCA uses a fixed port. You can not modify this attribute.
 

Username
Type a valid user name to connect to a Quadro VCA. If you are not sure what the correct user name is,
ask your system administrator or read the Quadro VCA manual.
 

Password
Type a valid password for the chosen user name to connect to a Quadro VCA.

 
HTTP Proxy
 
If you cannot reach an external Quadro VCA or Iray Server from your local network, you can establish a
connection to the Quadro VCA or Iray Server using an HTTP proxy server. Check with your system administrator
to find out whether or not an HTTP proxy server is already set up for your use.
 
Address
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Type a valid proxy server to a Quadro VCA. If you are not sure what the correct proxy server is, ask your
system administrator or read the Quadro VCA manual.

 
Username

Type a valid user name to connect to a Quadro VCA. If you are not sure what the correct user name is,
ask your system administrator or read the Quadro VCA manual.
 

Password
Type a valid password for the chosen user name to connect to a Quadro VCA.

 
Connect

As soon as you set up the server address, user name and password correct you can connect to the
Quadro VCA by clicking on the Connect button. After a successful login the Iray Resource Manager
shows the status of the Quadro VCA cluster. Red boxes indicates nodes used by other users.
 

Iray Resource Manager after successfully connecting to a Quadro VCA
 

Reserve Nodes
Click on Reserve Nodes to activate the reservation of the chosen number of render nodes. Each node
represents one single Quadro VCA. A selected number of nodes defines a cluster.
 

After a successful login and reservation of nodes, Iray Resource Manager shows the status of the Quadro VCA
cluster. Red boxes indicates nodes used by other users. Green boxes are reserved by Iray for Maya 2.2
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Iray Resource Manager after reserving nodes on a Quadro VCA
 
 

Invalid
This box appear red when the Iray for Maya version doesn't match with the version installed on the
Quadro VCA. Contact the system administrator.

 
No Cluster

This box appears yellow when Iray for Maya is connected to a Quadro VCA but no cluster is defined. A
cluster is a set of nodes. Each node represents one single Quadro VCA.
 

Ready
This box appears green when nodes are reserved and can be used by Iray for Maya.
 

Release Nodes
Hit this button after your rendering session is finished. This will release the reserved nodes for other
Quadro VCA users.

 
Note: When the setup of the Quadro VCA is done Iray will not necessarily start rendering on the
Quadro VCA. The final decision to use local or cloud rendering will be done in the IFM Control
Box.
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IFM Control Box with selected Cloud Render Mode
 

After the basic setup is done close the Render Manager and open the IFM Control Box. In the section Cloud
Rendering of the IFM Control Box set Render Mode to Cloud. Now you can open the Render View window and
start rendering. The rendering will happen on the Quadro VCA cluster.
 
For more information, see the chapter “IFM Control Box”.
 
Note: When you finish rendering on the Quadro VCA it is important to release the nodes after
your session so that other user can have access to these nodes.

5.1.3 Iray Resource Manager for cloud rendering (Iray Server)
 
When choosing the Cloud tab, the Iray Resource Manager provides a user interface to connect to a Quadro VCA
or to Iray Server. Cloud Rendering lets Iray for Maya 2.2 render on a computer that is connected via Internet
or local network into Mayas Render View. Your local resource are not used by Iray when Cloud Rendering is
selected.
 
Note: When a connection to Iray Server is established, Iray will not necessarily start rendering
on the remote machine. The final decision to use local or cloud rendering will be done in the IFM
Control Box.
 



 

180

Iray Resource Manager to set up the cloud rendering using Iray Server.
 

Type
 You can choose to connect to a Quadro VCA or to Iray Server. To use Iray Server choose Iray Server.
 

Server Address
Type a valid server address to connect to Iray Server. If you are not sure what the correct address is, ask
your system administrator or read the Iray Server manual.
 

Server Port
Iray Server uses the port 9090 by default. If you are not sure what the correct port is, ask your system
administrator or read the Iray Server manual.
 

Username
Type a valid user name to connect to Iray Server. If you are not sure what the correct user name is, ask
your system administrator or read the Iray Server manual.
 

Password
Type a valid password for the chosen user name to connect to Iray Server.

 
HTTP Proxy
If you cannot reach an external Quadro VCA or Iray Server from your local network, you can establish a
connection to the Quadro VCA or Iray Server using an HTTP proxy server. Check with your system administrator
to find out whether or not an HTTP proxy server is already set up for your use.

 
Address
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Type a valid proxy server to Iray Server. If you are not sure what the correct proxy server is, ask your
system administrator or read the Iray Server manual.

 
Username

Type a valid user name to connect to a Quadro VCA. If you are not sure what the correct user name is,
ask your system administrator or read the Quadro VCA manual.

 
Password

Type a valid password for the chosen user name to connect to Iray Server.
 
Connect

As soon as you set up the server address, user name, and password correctly you can connect to Iray
Server by clicking on the Connect button. After successfully logging in, Iray Resource Manager shows the
status of Iray Server.
 

Iray Resource Manager after successfully connecting to a Iray Server
 

Invalid
This box appears red when Iray for Maya 2.2 doesn't match with the Iray Server version. In this case you
need to install the Iray Server version that fits to Iray for Maya 2.2 or contact your system administrator.

 
Ready

This box appears green when Iray for Maya is connected to Iray Server.
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Note: When the setup of Iray Server is finished, Iray will not necessarily start rendering on a
remote machine. The final decision to use local or cloud rendering is made in the IFM Control
Box.
 
 

IFM Control Box with selected Cloud Render Mode
 

After the basic setup is done close the Render Manager and open the IFM Control Box. In the section Cloud
Rendering of the IFM Control Box set Render Mode to Cloud. Now you can open the Render View window and
start rendering. The rendering will happen on the remote machines connected to Iray Server.
 
For more information, see the chapter “IFM Control Box”.

 

5.2 Iray Queue Manager
 

The Iray Queue Manager allows converting and sending a Maya scene to the Iray Server render queue. The
Queue Manager only sends the scene to the Iray Server render queue. It does not start or manage the Iray
Server render queue. This is done in a browser using the tools that come with Iray Server, in this case, the
Queue page. To see how to open the Iray Server Queue Page in a browser please refer to the Iray Server
documentation.
 
Also it is important to know that using the Iray Server render queue the resulting image format will differ from the
results when used with Maya's Batch Render or the command line rendering. Not all features provided by Iray for
Maya will be available when using Iray Server.
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Note:
•  The Queue Manager is only available via the IFM Control Box.
 

    
IFM Control Box

 
•  The Queue Manager looks similar to the Resource Manager's Cloud tab. However, keep
in mind that the Resource Manager only manages the resources used in the Render View
inside Maya. It does not control the resources using batch rendering, command-line
rendering, or cloud rendering.
•  The Queue Manager only handles the connection to a given Iray Server or Quadro VCA
and submits data to this cluster. This has nothing to do with Maya's Batch Render or
Maya's command line render.
 
 

 
 

5.2.1 Queue Manager attributes for Quadro VCA
 
Before you can use the Queue Manager with a Quadro VCA you need:
 

•  A network connection
•  A username and a password

 
Please read the Quadro VCA manual or ask your system administrator.
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Iray Queue Manager
 
Type
You can choose to connect to a Quadro VCA or to Iray Server. To use a Quadro VCA, choose VCA.
 
Server Address
Type a valid server address to connect to a Quadro VCA. If you're not sure which is the correct address ask your
system administrator or read the Quadro VCA manual.
 
Server Port
Quadro VCA uses a fixed port. You can't modify this attribute.
 
Username
Type a valid username to connect to a Quadro VCA. If you're not sure which is the correct username ask your
system administrator or read the Quadro VCA manual.
 
Connect
As soon as you set up the server address and username correct you can connect to the Quadro VCA by clicking
the Connect button. A window will pop up and ask for a password. Of course the password must fit to the user
name you entered.

5.2.2 Queue Manager attributes for Iray Server
 
Before you can use the Queue Manager with Iray Server you need:
 

•  A network connection
•  A username and a password

 
Please read the Iray Server manual or ask your system administrator.
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Iray Queue Manager
 
Type

You can choose to connect to a Quadro VCA or to Iray Server. To use a Iray Server, choose Iray Server.
 
Server Address

Type a valid server address to connect to Iray Server. If you're not sure which is the correct address ask
your system administrator or read the Iray Server manual.

 
Server Port

Iray Server uses the port 9090 by default. If you're not sure if it is the correct port ask your system
administrator or read the Iray Server manual.

 
Username

Type a valid username to connect to Iray Server. If you're not sure what the correct username is, ask your
system administrator or read the Iray Server manual.

 
Connect

As soon as you set up the server address and user name correct, you can connect to Iray Server by
clicking the Connect button. A pop-up window is displayed where a password is requested. Of course the
password must fit to the username you entered.

5.2.3 Queue Manager attributes for scene submission
 

After a connection is established, the Queue Manager's user interface looks identical for Quadro VCA and Iray
Server.
 
Note: When submitting a Maya scene to Iray Server, it is important to know that only the active
render layer will be submitted. The Queue Manager will ignore the regular Maya behaviour of
Render Layers. This means it doesn't matter if a Render Layer is marked as renderable or not;
the Queue Manager will submit the Render Layer which is selected in the Channel Box Render
tab.
 
Name
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Sets a name for the scene that is used to identify the render job in the render queue. This name has
nothing to do with the Maya scene name and can be different.
 

Priority
Predefines a priority for the render job. Smaller values are higher priorities. This priority can later be
changed using the Iray Server render queue user interface. Please check the Iray Server documentation
for details.
 

Image Format
Defines output image format.
 

Note: When using the Queue Manager the settings for the output image format are different than
using command line rendering or Batch Render. The resulting image may differ from images you
render with command line rendering or Batch Render.
 
Resolution

Sets the render resolution defined in the Render Settings window to the selected percentage. This is
usefull when doing fast preview renderings to have a fast access to the resulting resolution.
 

Submit
 Sends the actual scene to the Iray Server render queue.

 
Note: Sending doesn't mean that the render queue will be started. You need to go to the Iray
Server render queue user interface to start the queue. Starting the render queue can't be
performed from Maya. See the Iray Server documentation to learn more about the Iray Server
render queue.
 

5.3 Logging Manager
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Logging Manager UI
 

While Iray is rendering it sends log messages in Mayas Output Window. The Iray Logging Manager gives you
control about the detail of Iray's log messages. Only modify the settings in this window if you know what you do.
This window is meant for debugging purpose.
 
Log Prefix
 
Time

Shows the time of the listed action in the format day month date h:min:sec year.
 
Time Seconds

Time stamp in seconds with miliseconds resolution. This feature is meant for debugging.
 
Host Thread

Lists the host number first and then the threat number. This feature is meant for debugging.
 

Host Name
 Displays the hostname on which the listed action happens.

 
Module

Displays the listed program module that is responsible for the listed action.
 
Category

Displays the category name of the log level.
 
Severity

Displays the meaning or relevance of the action.
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Log Levels
 

Logging Manager UI
 
There are six different levels that triggers the frequency of the listed categories:
 
fatal

Prints a message if a fatal error has occurred. This log level gives the fewest output.
 

error
Prints a message if an error has occurred.

 
warning

Prints a message if a warning has occurred.
 
info

This is a normal operational message.
 
verbose

This is a more verbose message.
 
debug

Prints a message for every action Iray does. This level gives the most information but slows down render
time significant.

 
The available categories are:
 
Overall Level
 

This attribute doesn't describe a category but the highest output level possible, for example, if this is set
to fatal. All other categories only display the fatal messages, doesn't matter what is set individual in each
single category. To visualize this behaviour, all categories that are not considered become red.

 
    In the following screenshot you see that the Overall Level is set to info:
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Iray Logging Manager UI
 

The categories Database, Disk, Geometry, Image and Render are OK because the chosen log levels are a
subset of the log level info. IO, Main, Misc, Memory, Network and Plugin appear red because the log level
verbose is higher than the Overall Level info. For these categories you will see only the messages with the log
level info.
 
Database

This category lists action related to theraw disk I/O and swapping.
 

Disk
This category lists action related to the database.

 
Geometry

This category lists action related to geometry processing, e.g. tesselation.
 
Image

This category lists action related to texture processing, image and video plugins.
 
Main

This category is reserved for the application itself.
 
Misc

This category lists action related to everything that isn't covered by the other categories.
 
Memory

This category lists action related to the memory management.
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Network

This category lists action related to the network traffic.
 
Plugin

This category lists action related to plugins unless other categories fit better.
 
Render

This category lists action related to the rendering process. This category shows the progress and could
be set to the log level info or verbose.

5.4 Streaming Manager
 
The Streaming Manager is used to stream the content of the Render View to a web site. This technology is
used to handle remote sessions. Currently the Streaming Manager is in beta. A detailed documentation is under
construction.

6 Render Settings
 

Open the Maya Render Settings from the main menu: Window ➤ Rendering Editors ➤ Render Settings. You can
choose between Iray Photoreal or Iray Interactive as the current renderer.
 
Note: Iray Photoreal and Iray Interactive share some attributes. These attributes are collected in
the Common and the Iray Common section.
 
 

Render Settings UI showing the Common tab active
 

6.1 Common tab
 

The Render Settings common tab works as expected. It handles file formats, sequence rendering, image size,
and so on. Most of the attributes work as expected. The sections with different attributes and functions are
described in the following chapters
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Note: The Color Management tab is not supported.
 
 

Render Settings UI

6.1.1 Image formats
 

Iray for Maya supports the following image formats: JPEG, OpenEXR, OpenEXR Multilayer, PNG, Targa and Tiff.
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Render Settings File Ouput UI
 

 

6.1.2 Common settings for all 8/16-bit formats
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Image Settings 8-16-bit  UI
 
 

Depth Mode custom
Uses the attribute Min. Depth and Max. Depth to define the closest (black) and farthest (white) distance.

 
Depth Mode optimal maximum

Uses the attribute Min. Depth plane to define the closest (black) distance.
 

Depth Mode optimal range
Uses the auto clipping plane used by the camera to define the closest (black) and farthest (white)
distance.
 

Depth Mode near/far from camera
Uses the near and far clipping plane set in the camera to define the closest (black) and farthest (white)
distance.
 

Distance Mode custom
Uses the attribute Min. Depth and Max. Depth to define the closest (black) and farthest (white) distance.

 
Distance Mode optimal maximum

Uses the attribute Min. Depth plane to define the closest (black) distance.
 

Distance Mode optimal range
Uses the auto clipping plane used by the camera to define the closest (black) and farthest (white)
distance.

6.1.3 JPEG settings
 
The UI for the JPEG settings is much the same as for the other 8/`6 bit formats. There is just one additonal
attribute to adjust the compression level.
 

Image Settings for JPEG-Format UI
 

Quality
Sets the compression level in percent.

6.1.4 OpenEXR / OpenEXR multilayer settings
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Image Settings for OpenEXR-Format UI

 
 

Compression
Sets the compression method to uncompressed, ZIP, RLE, ZIPS, PIX, PXR24 (lossy), B44 (lossy), B44A
(lossy), DWAA (lossy) or DWAB (lossy)
 

Color Type
Defines the bit depth for the color.

 
Scalar/Vector Type

Defines the bit depth for the scalar values and vector.
 

Id Type Id
Sets the Id type to integer values. The image related canvases Object Id and Material Id will appear
black.
 

Id Type Color Coded
The image related canvases Object Id and Material Id will show a RGB image. Each Object Id and
Material Id will be displayed in a unique color.

 
Stereo Mode Single View Files

Use this option in combination with the Output attribute, both are in the Attribute Editor, to render two
separate images in EXR image file format for the left and right camera view at the same time.

 
Stereo Mode Multi-View File (Default left)

Use this option in combination with the Output attribute, both are in the Attribute Editor, to render one
image containing the left and right camera view at the same time according to the standard for storing
multiple views in a single OpenEXR. The default or main layer contains the image seen by the left
camera.

 
Stereo Mode Multi-View File (Default right)

Use this option in combination with the Output attribute, both are in the Attribute Editor, to render one
image containing the left and right camera view at the same time according to the standard for storing
multiple views in a single OpenEXR. The default or main layer contains the image seen by the right
camera.

 
Attributes

The user is now able to add custom information to the exr-file using the Attributes section in the
OpenEXR Settings window.
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6.1.5 PNG settings
 
The UI for the PNG settings is much the same as for the other 8/16 bit formats. There is just one additonal
attribute to adjust the Bit Depth.
 

Image Settings for PNG-Format UI
 
 

Bit Depth
Sets the bit depth of the color.

6.1.6 Targa settings
 
The UI for the Targa settings is the same as for the other 8/`6 bit formats.
 
Note: Targa images are always rendered with an 8 bit color depth.
 

Image Settings for Targa-Format UI

6.1.7 Tiff settings
 
The UI for the Tiff settings is much the same as for the other 8/16 bit formats. There are just three additonal
attributes to modify the output.
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Image Settings for Tiff-Format UI
 

Color Type
Defines the bit depth for the color.
 

Scalar/Vector Type
Defines the bit depth for the scalar and vector values.

 
Id Type

Defines the bit depth for the color. The image related canvases Object ID and Material ID will show a
RGB image. Each Object ID and Material ID will be displayed in a unique color.

6.2 Iray Common
 

Use the Iray Common tab to set attributes common to Iray Photoreal and Iray Interactive.
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Iray Common tab in the Render Settings Window

6.2.1 General attributes
 

Iray Common general attribures UI
 

Write
When this attribute is set the content of the Render View-window will be saved automatically to the hard
disk when [Render ➤ Render Current Frame] is done or aborted.
 

Write (IPR)
When this attribute is set the content of the Render View-window will be saved automatically to the hard
disk when an IPR rendering is done or aborted.
 

Shadow Terminator Offset
•  When this attribute is set to On Iray uses an offset to eliminate self-shadowing artifacts know as
"Terminator effect" for the entire scene.
•  When this attribute is set to Off Iray no offset will be applied to eliminate self shadowing artifacts.
•  When this attribute is set to User the offset will not effect the entire scene. The offset will only be applied
to objects with the local attribute Shadow Terminator Offset set in the objects Attribute Editor in the Iray
section.
•   
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Sphere showing the self-shadowing artifact know as "Terminator Effect"
 
 

Sphere showing the same scene as above but with Shadow Terminator Offset set to On
 
 

6.2.2 Environment attributes
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Iray Common environment attributes
 
 

Precision
Sets the resolution of the exr-image used by the Iray for Maya IBL-node during batch rendering. Higher
values will increase the render time, especially when using lots of IBL-nodes in one scene. When the
attribute is set to custom any resolution can be set using the attribute Custom Height.

 
Custom Height

Defines the vertical resolution of the exr-image in pixels.
 

Precision (IPR)
Sets the resolution of the exr-image used by the Iray for Maya IBL-node during interactive rendering.
Higher values will increase the render time, especially when using lots of IBL-nodes in one scene. When
the attribute is set to custom any resolution can be set using the attribute Custom Height.
 

Custom Height
Defines the vertical resolution of the exr-image in pixels.

6.2.3 Section Objects
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Section Objects attributes
 

Enable
Turn this attribute on to show section caps for Section Objects.
 

Color
When the attribute Enable is turned on the section cap is drawn in the selected color.
 



 

180

Enable turned off. This is the default behaviour when using Section Objects
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Enable turned on. The Section Object creates a cap showing the selected color.
 

6.2.4 Dome



 

180

Section Dome attributes
 
Using the Dome settings the user is able to modify the appearance of the enviornment behaviour, e.g. the
ifmImageBasedLighting node. By default the environment is mapped on an infinte sphere. using the different
modes in the Dome section makes it possible to change this behaviour. This enables a wider range of flexibility. 
E.g. it makes it easier to use the environment as background or create different lighting scenarios.
 
Mode

Infinite
Conventional infinite spherical environment lookup. This is the default behaviour.

 
Ground

Infinite spherical environment lookup, but with a textured groundplane.
 

Sphere
Finite size sphere shaped dome.
 

Box
Finite size box shaped dome.
 

Sphere with Ground
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Finite size sphere shaped dome where the lower part of the environment is projected onto the
plane dividing upper and lower parts of the sphere.
 

Box with Ground
Finite size box shaped dome where the lower part of the environment is projected onto the plane
dividing upper and lower parts of the box.
 

Origin
The origin of the dome in case it is of finite size.

 
Radius

The dome radius for modes Sphere and Sphere with Ground.
 

Size
The dome width, height and depth for modes Box and Box with Ground.
 

Rotation Axis
This axis defines the rotation axis for interactive rotations of the dome.
 

Rotation
Angle of rotation for interactive rotations of the dome. The range of the rotation angle is [0,1].
 

Texture Scale
Used to control the texture projection of the environment on the ground. This can be seen as an
equivalent to the distance from ground where the real life camera was placed to take the captured
environment map.

 
Visualize

Enables a false-color overlay of the finite size environment geometry. This can be used to align the
geometry with the projection of the captured environment map.

 

6.2.5 Implicit groundplane
 
The Implicit Groundplane is a special case of the more general concept of matte objects. It covers the case of
a planar surface acting as shadow catcher without the need of an explicit geometry. The Implicit Groundplane
works in Iray Photoreal and Iray Interactive.
 
This implicit ground plane weights the environment contribution of the ground using a progressive estimation
of the amount of shadow on the groundplane, caused by the objects in the scene (from direct light only). The
mode of the environment lookup itself remains unchanged as it is specified by the environment settings. The
groundplane is a special case of the more general concept of matte objects.
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Screenshot illustrating the effect of the implicit ground plane. The only polygonal geomety in this scenario is the gargoil character.
 

Iray Common Implicit Groundplane attributes
 
 
Enable

Enables the effect of the Implicit Groundplane.
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Height

Defines the position of the Implicit Groundplane along the world Y axis.
 

Shadow Intensity
Defines the darkness of the shadow effect on the Implicit Groundplane.
 

Reflectivity
If set to a positive value, enables reflectivity on the groundplane weighted by the fresnel term.
 

Glossiness
Controls the glossiness of the ground reflectivity. Useful values range from 0 (diffuse) to 10000000.0
(perfect mirror).
 

Direct Reflections Only
When set this attribute is enabled, the ground will only reflect objects directly, but not when seen from
reflections on other objects. Also, reflections will not replace the (optional) ground shadow, which allows
to have highly glossy reflections mixed with diffuse shadowing. For a more physically correct behaviour,
turn this attribute off will avoid this, but one has to take care to not mix strong ground shadows with a high
ground glossiness (which is equivalent to the behaviour of regular matte objects).
 

Visible from Below
When this attribute is turned off, one can see geometry located above the ground plane, even when the
camera is placed below it.
 

Connect to Environment
When set to Yes, secondary interactions with the matte object will use the environment instead of the
backplate.

 
Note: Only effective if a backplate function or the backplate color is set.
 
Connect from Camera

This additional flag makes the matte object behavior toggle between two different lookup types:
 

•  The first one is done locally (attribute is set to Yes), where similar interactions with the matte object (for
example, the same point of intersection) will deliver the exact same lookup into the real world photograph,
which usually works best for a very elaborate matte object setup specifically arranged for only a single or
very similar camera positions.
•  The second type is global (attribute is set to No), where the real interactions with the environment or
backplate are used instead, which is usually preferrable for simple matte object setups (like plain shadow
catchers) or full camera interaction.

 
Note: The attribute Connect from Camera will only be noticable in scenes where no backplate/
color at all is specified (so all interactions will always be happening with the environment), or if
a backplate/color is specified and the "Connect to Environment" flag is set in addition.
 

6.2.6 Material attributes
 
These attribute are only effective when Iray tries to render non-Iray materials.
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Ira Common Material attributes
 
 

Missing Material
Defines the color for non-Iray materials while rendering using batch or command line render.
 

Missing Material (IPR)
Defines the color for non-Iray materials while rendering using IPR.

6.2.7 Motion Blur attributes
 

To calculate motion blur, Iray chooses a time, "moves" the scene to that time, and
renders a certain amount of iterations before going on with the next time sample.
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Iray Common Motion Blur UI
 

Enable Motion Blur
Turns the motion blur calculation on or off.
 

Steps per Frame
Defines the accuracy of the interpolation between transformations of an object per frame. This value
defines how precise the animation curve is approximated for Motion Blur rendering. This attribute can
be overwritten on a per object base using the according attribute in the [Attribute Editor ➤ Iray] section of
each transform node.
 

Rotation Interpolation
Choose the interpretation for the calculation between rotation values. This attribute can be overwritten
on a per object base using the according attribute in the [Attribute Editor ➤ Iray] section of each transform
node.
 
Rotation Value

Interpolates the rotation values themselves.
 

Spherical
Uses the minimal rotation path to get to the position of the next time step.

 
Note:

Consider a full 360 degrees rotation, where the angle is 0 at the starting time step and
360 at the next one. Choosing Spherical will result in the minimal rotation between
both angles and thus there won' be any motion blur due to rotation. In order to get the
desired complete rotation, Rotation Value interpolation has to be chosen. Note that the
considered time steps depend on the Steps per Frame attribute.

 
Samples per Motion Sample
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Number of iterations rendered before the scene is updated to a different time value. You can adjust
the number of iterations for each time sample. If the simulation complexity originates more from the
illumination then motion increase this parameter, otherwise, i.e. motion is more difficult than illumination,
lower this parameter. Note that the actually number of iterations per motion sample is a power of 2, i.e.
increasing by one means doubling the iterations.

6.2.8 Post Denoiser attributes
 
The Post Denoiser is a tool to reduce noise for images rendered with Iray for Maya 2.2 using a deep-learning
based noise filter. This approach is different from the  Degrain Filtering which is in the Post Effect tab of the
Render Settings window. While the classic degraining filter can provide a moderate improvement in perceived
image quality, the Deep Learning-based denoiser typically provides more drastic changes.
 
Note:

While it is possible to enable both methods at the same time, this is not recommended
and can lead to unsatisfactory results.
 
The Deep Learning-based denoising filter is only available when running on GPU
hardware, since the inferencing step of Deep Learning systems is impractical to execute
on CPUs. Also note that the additional memory required for denoising might exhaust
device memory if almost all available memory is already in use by the renderer. In this
case, the whole postprocessing system will fall back to CPU in order to preserve device
memory, in consequence disabling denoising. Note especially that image resolution has a
large impact on memory consumption of this denoiser.
 
It is not recommended to use the Post Denoiser in combination with tile rendering.
 
Small details like metallic paint can be eliminated by the Post Denoiser.
 
The RGB values in the color buffers of the used HDR images must not be too low (dark).
The HDR version of the denoiser expects the RGB values in the range from zero to 10000.
If they are too low, like close to zero, the denoiser might create wrong colors and artifacts
in the denoised image.
 
Note that denoising images that have been blurred using the bloom filter will often lead
to unsatisfactory results, depending on the bloom filter's settings. It is therefore not
recommended to combine denoising and bloom. Additionally, since denoising can only
operate on low dynamic range images, tone mapping must be enabled.

 
 

Iray Common Post Denoiser UI
 

Max. Memory
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Defines the maximum amount of device memory the denoiser is allowed to use in Megabytes (default:
1024 MiB). Note that the denoiser may automatically use less memory than the value specified here,
depending on hardware used and current renderer memory usage, in order to balance denoising speed
and memory usage. It should normally not be necessary to change this value, even on devices with very
limited memory.
 

Denoise Alpha
If set to true, the alpha channel of RGBA images will be denoised, otherwise it will be left unchanged.
Note that setting this to true will approximately double the time needed for denoising. Older versions of
iray always denoised the alpha channel, if present.

 
Production Mode

Enables the Post Denoiser when using the batch render or command line render
 
Disabled

The Post Denoiser is not available
Enabled

Turns the Post Denoiser on. Only the denoised image is written.
Both

Turns the Post Denoiser on. Iray writes the regular and the denoised image.
 

Available IPR
Turns the Post Denoise on and makes it available for the use in IPR. By itself, this option does not cause
any changes in the output image.
it just triggers generation of all additional data needed for denoising to make sure it is available in case
denoising is enabled later during progressive rendering. If set to true, this option may incur a small
memory and performance overhead and should be set to false if denoising is not desired.

 
Enable IPR

If set, the denoiser will process the rendered image. If the attribute Available in IPR is not set, this option
has no effect. It is not necessary to re-start progressive rendering of an image when changing this option.
Turn this attribute on or off will show the resulting image in the Render View.
 

Start Iteration (IPR)
If the denoiser is enabled, this option will prevent denoising of the first few iterations, with the value
specified in this option being the first denoised iteration. This can prevent the denoiser's performance
overhead from impacting interactivity e.g. when moving the camera. Additionally, the first few iterations
are often not suitable as input for the denoiser due to insufficient convergence, leading to unsatisfactory
results.

6.2.9 Region attributes
 
The attributes for region rendering always defines a part of the image relative to the final resolution.
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Iray Common Region rendering UI
 
 

Active
Sets the region rendering on or off.
 

Left
Specifies the position of the furthest left point of the region to be rendered.

 
Right

Specifies the position of the furthest right point of the region to be rendered.
 
Top

Specifies the position of the furthest top point of the region to be rendered.
 

Bottom
Specifies the position of the furthest bottom point of the region to be rendered.
 

Get marquee from render view
When a region in the Render View panel is interactively defined by the user, this button copies the values
from the Render View into the attributes Left, Right, Top, and Bottom.

6.2.10 Legacy attributes
 

Because of technical reasons the behaviour of specific features will change vom release to release. In some
cases this might have the effect that the same scene will render slightly different when using a different Iray for
Maya version. The Legacy attribute will help to recover the "old" behaviour.
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Iray Common Legacy UI
 

Ignore scene units
When enabled, Iray ignores the working units set in the Maya preferences. Enabling or disabling this
attribute triggers differences when rendering a scene. The main impact of this attribute is visible when
using:

 
•  Material emitters that use intensity_power as Intensity mode
•  ifmDielectric using volume scattering

 
Note:

•  When using external MDL files such as NVIDIA vMaterials, disable this attribute to
ensure the materials work correctly.
•  When importing scenes from Iray for Maya release 65 and subsequent releases, enable
this attribute to ensure the same rendering results as in previous Iray for Maya versions.
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6.3 Iray tab: Interactive selected
 

The Iray Interactive tab gives control over attributes that are specific for Iray Interactive.
 

Iray tab in the Render Settings window when Iray Interactive is selected

6.3.1 General attributes
 



 

180

Iray tab when Iray Interactive is selected
 
 

Indirect Light Mode
Sets the approximation method for indirect lighting
 
Type off

Calculates no indirect lighting except specular transmission and reflection.
 
Type coarse scale

Calculates diffuse indirect illumination.
 
Note:

The coarse mode is suitable to obtain a fast early impression of the indirect illumination
in the scene. At the first primary hit point, the indirect illumination does only contribute to
the diffuse layers, which means that glossy contributions are only taken into account at
secondary hits and beyond.

 
fine scale

Calculates indirect illumination, including glossy and measured BRDFs.
 
Note:

In fine scale mode, all reflective layers, including glossy and measured BRDFs, of the
material receive indirect illumination. Furthermore, indirect illumination from the close
vicinity of the shading location is taken into account more accurately.

 
Firefly Filter

The FireFly Filter automatically rejects outliers which would lead to displeasing low-frequency
contributions which converge away only slowly. This is similar to the FireFly Filter in Iray Photoreal.
However, this means that some contributions are cut-off.
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Shadows

Allows shadows to be forcibly turned off
 

Ibl Falloff
If this flag is enabled, the Falloff min/max Distance parameters in the Ambient Occlusion and Lighting
section also affect raytraced occlusion for IBL and instant sun and sky.
 

Depth
Maximum trace depth settings are respected by Iray Interactive. This attribute controls the overall number
of trace depth.
 

Depth Reflect
This value correspond to the maximum total number of bounces and maximum number of reflections.
 

Depth Refract
This value correspond to the maximum total number of refractions and maximum number of shadow
refractions respectively.
 

Ray Importance Threshold
If the contribution of a specular reflection or refraction bounce falls below this value it is cut off. The lower
the value the more accurate the result. The tradeoff is elapsed time. Compared to limiting the trace depth,
using this setting usually results in a better performance-quality ratio.

6.3.2 Ambient occlusion attributes
 

Iray tab when Iray Interactive is selected
 

Occlusion Mode
This setting only affects the Ambient Occlusion output canvas.

 
Type diffuse



 

180

The setting corresponds to the common diffuse ambient occlusion calculation, which integrates
the visibility weighted by the cosine of the direction and the normal over the hemisphere.

 
Type environment

This settings lights the scene under the actual environment used in the scene. The environment-
guided ambient occlusion results in a color output.

 
Intensity

Controls the intensity of additional ambient lighting.
 

Falloff max Distance
Distance beyond which potential occlusion does not influence result of ambient lighting and ambient
occlusion.
 

Falloff min Distance
Distance below which all potential occlusion fully influences result of ambient lighting and ambient
occlusion.
 

Falloff Exponent
Exponent to be used for weighting the occlusion value between Falloff min and max distance. The default
1 blends linearly.
 

Falloff Distance Space
Defines whether the Falloff min and max Distance values correspond to world space or raster space.

6.3.3 Filtering attributes
 

Iray tab when Iray Interactive is selected
 

Type
The attribute Type describes the shape of the pixel filter.
 

Type Box
A Box filter is selected to determine the pixel sampling. It sums all samples in the filter area with
equal weight. Fast, but not very accurate.

 
Type Triangle
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 A Triangle filter is selected to determine the pixel sampling. It weights the samples using a
pyramid centered on the pixel. Slower, but good results.

 
Type Gauss

A Gaussian filter is selected to determine the pixel sampling. It weights the samples using a
Gauss (bell) curve centered on the pixel. Slowest, but better results.

 
Radius

This attribute defines the size of the pixel sample. Large filter size blurs the image.

6.3.4 Termination Criteria attributes
 

Iray tab when Iray Interactive is selected
 

 
Max. Samples

Sets the maximum numbers of iterations to be calculated. When this number is reached Iray stops the
calculation of the image.
 

Max. Time
Sets the time limit for the rendering in hours:minutes:seconds. When the render time exceed the value in
this attribute Iray stops the calculation of the image.

6.4 Iray tab: Photoreal selected
 

The Iray Photoreal tab gives control over attributes that are specific for Iray Photoreal.
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Iray tab in the Render Settigns Window when Iray Photoreal is selected

6.4.1 General attributes
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Iray tab in the Render Settings Window when Iray Photoreal is selected
 

 
Max. Path Length

Limits the maximum number of bounces of light paths which contribute to the rendering result.
Decreasing this value cuts off indirect lighting contribution but speeds up render time. Increasing the
value adds physical accuracy but slows down render time.
 

Caustic Sampler
Improves the quality of caustic but takes longer to calculate.
 

Architectural Sampler
The Architectural Sampler is discontinued by Nvidia and removed from the UI.
 

Nominal Luminance
The nominal luminance is a hint to Iray on what is considered a "reasonable" luminance level when
viewing the scene. This luminance level is used internally to tune the firefly filter and error estimate.
When the nominal luminance value is set to 0, Iray will estimate the nominal luminance value from the
tonemapper
settings.

 
Recommendations:
For visualization, a reasonable nominal luminance would be the luminance value of a white
color that maps to half the maximum brightness of the intended display device. For quantitative
architectural daylight simulations a reasonable nominal luminance could be the luminance of
white paper under average day light.
 
FireFly Filter

Controls a built-in filter to reduce bright spots that may occur under some difficult lighting conditions. Such
bright undesired pixels are often called “fireflies.” Consistency is not affected by this filter: fireflies are
automatically detected and masked out in the early rendering stage when variance is high but eventually
these missing contributions are faded back in over time. Thus, the results at a low sample count may
appear slightly darker than the final, converged image. The filter works best in combination with the built-
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in tonemappers. If a tonemapper is not enabled, the filter estimates can be too pessimistic for some
scenes, resulting in some fireflies to still appear.
 

Effect of different values for Nominal Luminance
 
 

6.4.2 Filtering attributes
 

Iray tab in the Render Settigns Window when Iray Photoreal is selected
 

Type
The attribute Type describes the shape of the pixel filter.
 

Type Box
 A Box filter is selected to determine the pixel sampling. It sums all samples in the filter area with
equal weight. Fast, but not very accurate.



 

180

 
Type Triangle

 A Triangle filter is selected to determine the pixel sampling. It weights the samples using a
pyramid centered on the pixel. Slower, but good results.

 
Type Gauss

A Gaussian filter is selected to determine the pixel sampling. It weights the samples using a
Gauss (bell) curve centered on the pixel. Slowest, but better results.

 
Radius

This attribute defines the size of the pixel sample. Large filter size blurs the image.

6.4.3 Termination criteria attributes
 

Iray tab in the Render Settigns Window when Iray Photoreal is selected
 
 

Min. Samples
Controls the minimum number of iterations that need to be rendered before the progressive render loop is
allowed to terminate by any of the termination criteria.
 

Max. Samples
Sets the maximum numbers of iterations to be calculated. When this number is reached Iray stops the
calculation of the image.

 
Max. Time

Sets the time limit for the rendering in hours:minutes:seconds. When the render time exceed the value in
this attribute Iray stops the calculation of the image.

 
Quality Estimate Enabled

The convergence quality estimate is only available in the non-interactive render mode and can, in
addition, be enabled and disabled with this attribute. If disabled, rendering will not stop based on the
convergence quality and no progress messages will be issued for the current convergence quality.
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Quality

A convergence estimate for a pixel has to reach a certain threshold before a pixel is considered
converged. This attribute is a relative quality factor for this thresh-hold. A higher quality setting asks for
better converged pixels, which means a longer rendering time. Render times will change roughly linearly
with the given value, i.e., doubling the quality roughly doubles the render time. The value range for this
attribute is 0 to 100.

 
Converged Pixel Ratio

If the progressive rendering quality is enabled, this attribute specifies a threshold that controls the
stopping criterion for progressive rendering. The value range for this attribute is 0 to 1. Higher values will
increase quality but also render time.

6.4.4 Responsiveness
 

Iray tab in the Render Settigns Window when Iray Photoreal is selected
 

Update Interval
The update interval time in seconds is compared to the rendering time since the beginning of this
interactive render call. This acts as a hint to the renderer. Longer times will generally increase rendering
efficiency, while shorter times yield more frequent updates. When this values is set to 1 no update will be
shown until one of the termination criteria was reached.

 
Update Interval (IPR)

The update interval time in seconds is compared to the rendering time since the beginning of this
interactive render call. This acts as a hint to the renderer. Longer times will generally increase rendering
efficiency, while shorter times yield more frequent updates.

 
Min. Samples per Update

Defines the minimum number of samples to be calculated before showing an updated image

6.5 Post effect tab: Iray Interactive selected
 

The Post Effect tab allows some actions to be applied after the render process to the image.
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Post Effects tab in the Render Settigns Window when Iray Interactive is selected

6.5.1 Bloom Filtering attributes
 

Post Effects tab in the Render Settigns Window when Iray Interactive is selected
 

Bloom Filtering, sometimes referred to as light bloom or glow, is used to reproduce an imaging artifact of real-
world cameras. The effect produces fringes (or feathers) of light extending from the borders of bright areas in
an image, contributing to the illusion of an extremely bright light overwhelming the camera or eye capturing the
scene.
 
Enable

Enables or disable the Bloom Filtering effect.
 

Radius
Sets the blur radius of the bloom filter, specified as fraction relative to the output resolution. As a rule
of thumb smaller values create a local effect around bright areas of the image usually recognized as
specular highlights.
 

Threshold
Specifies the threshold to cut off bright spots in the image and blur these in a second step. As a rule of
thumb higher values create more spottiness.
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Brightness Scale
Scaling factor for the blurred bright spots when composited.
 

 Rendering with the bloom filter

6.6 Post effect tab: Iray Photoreal selected
 

The Post Effect tab allows some actions to be applied after the render process to the image.
 

Post Effects tab in the Render Settigns Window when Iray Photoreal is selected
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6.6.1 Degrain Filtering attributes
 

Post Effects tab in the Render Settigns Window when Iray Photoreal is selected
 

Degrain Filtering can reduce low frequency noise without sacrificing overall sharpness. These are intended to
be used in the final stage of the rendering phase, mainly to reduce remaining subtle grain in difficult areas of a
scene.
 
Note:

Unfortunately there is no general recommendation on which degrain filter mode will
perform best on a specific scene, thus it is necessary to cycle through the different
modes manually to receive the best results for a given scene. As a rule of thumb, modes
3 and 5 are usually the most reliable ones, with 5 being the more aggressive of the two.
Also note that the overall rendering performance can be reduced noticeably on low end
CPU cores, thus the filter should only be enabled in the final phase of the rendering
process.
 

Mode
Mode 0 disables the degrain function. Modes 1 to 3 are working very conservative and should thus be
safe to use in general, modes 4 and 5 are considered to be more aggressive and should be used with
caution, especially if the scene features fine details in either geometry or applied materials. As these
filters can be tweaked during the rendering process, it is recommended to experiment with different radius
settings to achieve best results.

 
Radius

This value should be reduced if the filter smooths out edges, and increased if some noise still remains in
the image.
 

Blur Difference
Modes 4 and 5 feature an additional setting that limits the influence of neighboring pixels if the brightness
is too different. Higher values create a more blurry effect.

6.6.2 Bloom Filtering attributes
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Post Effects tab in the Render Settigns Window when Iray Photoreal is selected
 
Bloom Filtering, sometimes referred to as light bloom or glow, is used to reproduce an imaging artifact of real-
world cameras. The effect produces fringes (or feathers) of light extending from the borders of bright areas in
an image, contributing to the illusion of an extremely bright light overwhelming the camera or eye capturing the
scene.
 
Enable

Enables or disable the Bloom Filtering effect.
 

Radius
Sets the blur radius of the bloom filter, specified as fraction relative to the output resolution. As a rule
of thumb smaller values create a local effect around bright areas of the image usually recognized as
specular highlights.
 

Threshold
Specifies the threshold to cut off bright spots in the image and blur these in a second step. As a rule of
thumb higher values create more spottiness.

 
Brightness Scale

Scaling factor for the blurred bright spots when composited.
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 Rendering with the bloom filter

6.7 Output tab: Iray Interactive selected
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Render Settings Output tab when Iray Interactive is selected
 

The Render Settings Output tab enables the user to render different render passes into so called canvases. This
can be achieved by using predefined or custom Light Path Expressions (LPEs).
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6.7.1 Color Canvases attributes
 

Render Settings Output tab when Iray Interactive is selected
 

Iray can render up to twenty color canvases in a single rendering process. For Iray Interactive only the mode
"Radiance" is available.
 
Type
For each color canvas exists a separate section to configure it:
 

Type Disabled
This canvas is disabled, i.e. no image is written.

 
Type All

A framebuffer that contains the so-called beauty pass (emission, diffuse, glossy, and specular).
 
Type Diffuse

A framebuffer that contains the diffuse contribution, i.e. "L.*DE". The last event on the light path
before the eye was a diffuse event.

 
Type Glossy

A framebuffer that contains the glossy contribution, i.e. "L.*GE". The last event on the light path
before the eye was a glossy event.

 
Type Specular

A framebuffer that contains the specular contribution, i.e. "L.*SE". The last event on the light path
before the eye was a specular event.

 
Type Emission

A framebuffer that contains the emission contribution, i.e. "LE", from directly visible light sources
and emitting surfaces.

 
Type Environment
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A framebuffer that shows only the emission from the environment light, i.e. "LeE".
 
Alpha

This attributes allows to toggle whether an alpha channel for the predefined framebuffer should
be rendered or not. The content of the written alpha channel varies between the predefined LPE
Diffuse, Glossy, Specular, Emission and Environment.

 
Type Light Pass Expression

A framebuffer that contains the contribution if all light paths defined by the LPE attribute.
 
Alpha LPE

A framebuffer that contains objects contribute to the Alpha channel defined by the LPE attribute.
 
Note:
 

If Light Path Expression is chosen only an alpha channel will be written until a valid Light
Path Expression for Alpha LPE exists.
 
•  A valid LPE and Alpha LPE result in a RGBA image
 
•  A valid LPE and no valid Alpha LPE result in a RGB image
 
•  No valid LPE and a valid Alpha LPE result in an A image

 
 

6.7.2 Auxiliary Canvases attributes
 

Render Settings Output tab when Iray Interactive is selected
 

 
Ambient Occlusion

A framebuffer that contains the ambient occlusion in the scene in the range from 0 (fully occluded) to 1
(not occluded).
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Depth
A framebuffer that contains the depth of the hit point along the (negative) z-coordinate in camera space.
The depth is zero at the camera position and extends positive into the scene. This channel is also known
as z-depth in other packages and mostly used for compositing.

 
Distance

A framebuffer that contains the distance between the camera and the hit point measured in camera
space. The distance is zero at the camera position and extends positive into the scene.

 
Normal

A framebuffer that contains the normalized surface shading normal in camera space excluding any effects
from normal perturbation functions.

 
Object Id

A framebuffer that contains a single color for each geometry. Each shape node has an attribute named
Object Id. The integer value set in this attribute defines the color the object gets in the framebuffer. The
color is the same in every frame over an animation.

 
Material Id

A framebuffer that contains an internal implementation-specific Id of the surface material. This Id can be
used to identify regions in the image that show the same material or regions without material, in particular
the background, where the Id is zero. Because the material id is calculated by a random integer number
at the beginning of the rendering, the color may vary in every frame over an animation.

 
Shadow

A framebuffer that contains the shadow in the scene. More precisely, the canvas contains the light
contributions that are missing at a certain point because it is blocked by a some object, the shadow
casters.

6.8 Output tab: Iray Photoreal selected
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Render Settings Output tab when Iray Photoreal is selected
 

The Render Settings Output tabs enables the user to render different render passes into so called canvases. This
can be achieved by using predefined or custom Light Path Expressions (LPE).

6.8.1 Color canvases attributes
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Render Settings Output tab when Iray Photoreal is selected
 

Mode
Iray can render up to twenty color canvases in a single rendering process. There are the two different
modes "Radiance" and "Irradiance" to control the type of rendered images of all of the twenty color
canvases.

 
Mode Radiance

Using this mode the radiance scattered from the seen objects onto the camera sensor is collected
in the color canvases. This is the usual mode.

 
Mode Irradiance

Contrary to the Mode Radiance, this mode collects the incoming light at the seen objects.
 

Mode Radiance exposes the Matte Shadow Affects Alpha attribute
 

Matte Shadow Affects Alpha
Use this attribute to define if shadows will be shown in the alpha mask of active matte objects.
 

Note:
 

This attribute is only visible when Mode Radiance is selected.
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GUI to select the different canvas types
 

Type
For each color canvas exists a separate section to configure it:

 
Type Disabled

This canvas is disabled, i.e. no image is written.
 

Type All
   A framebuffer that contains the so-called beauty pass (emission, diffuse, glossy, and specular).
 

For Mode Radiance there are already the following predefined types:
 

Type Diffuse
A framebuffer that contains the diffuse contribution, i.e. "L.*DE". The last event on the light path
before the eye was a diffuse event.

 
Type Glossy

 A framebuffer that contains the glossy contribution, i.e. "L.*GE". The last event on the light path
before the eye was a glossy event.

 
Type Specular

A framebuffer that contains the specular contribution, i.e. "L.*SE". The last event on the light path
before the eye was a specular event.
 

Type Emission
A framebuffer that contains the emission contribution, i.e. "LE", from directly visible light sources
and emitting surfaces.

 
Type Environment

A framebuffer that shows only the emission from the environment light, i.e. "LeE".
 



 

180

Alpha
This attributes allows to toggle whether an alpha channel for the predefined framebuffer should be
rendered or not. The content of the written alpha channel varies between the pre-defined LPE Diffuse,
Glossy, Specular, Emission and Environment.

 
Type Light Pass Expression

A framebuffer that contains the contribution if all light paths defined by the LPE attribute.
 
Alpha LPE

A framebuffer that contains objects contribute to the Alpha channel defined by the LPE attribute.
 
Note:
 
If Light Path Expression is chosen only an alpha channel will be written until a valid Light Path
Expression for Alpha LPE exists.

 
•  A valid LPE and Alpha LPE result in a RGBA image
•  A valid LPE and no valid Alpha LPE result in a RGB image
•  No valid LPE and a valid Alpha LPE result in an A image
 
 

6.8.2 Auxiliary canvases attributes
 

Render Settings Output tab when Iray Photoreal is selected
 
 

Enable Antialiasing
Enables antialiasing for the Auxiliary Canvases.

 
Note:

When turning on Enable Antialiasing for the Auxiliary Canvases note the following:
 
•  In the Depth and Distance canvas the antialiasing is only visible when objects
are overlapping. When objects are visible in front of the background ( blank scene,
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environment or image plane) the contour is not antialiased but shrinks. To get a proper
depth or distance canvas you must turn Enable Antialiasing off.
 
•  The attribute Radius under [Render Settings ➤ Iray ➤ Filtering] affects the appearance of
the object mask.

 
Depth

A framebuffer that contains the depth of the hit point along the (negative) z-coordinate in camera space.
The depth is zero at the camera position and extends positive into the scene. This channel is also known
as z-depth in other packages and mostly used for compositing.

 
Distance

A framebuffer that contains the distance between the camera and the hit point measured in camera
space. The distance is zero at the camera position and extends positive into the scene.

 
Normal

A framebuffer that contains the normalized surface shading normal in camera space excluding any effects
from normal perturbation functions.

 
Object Id

A framebuffer that contains a single color for each geometry. Each shape node has an attribute named
Object Id. The integer value set in this attribute defines the color the object gets in the framebuffer. The
color is the same in every frame over an animation.

 
Material Id

A framebuffer that contains an internal implementation-specific Id of the surface material. This Id can be
used to identify regions in the image that show the same material or regions without material, in particular
the background, where the Id is zero. Because the material id is calculated by a random integer number
at the beginning of the rendering, the color may vary in every frame over an animation.

7 Batch and command line rendering
 

A Maya scene file can be rendered "outside" the Render View window with Iray Photoreal and Iray Interactive
using the Maya Batch Render or Command Line Renderer.

7.1 Batch rendering
 

To use the Batch Render from the Maya main menu it is necessary to select the Iray Photoreal or Iray Interactive
in the Render Settings or in the Render View window first. When this is done select from the main menu
[Rendering ➤ Render ➤ Batch Render]. Click on the square beside Batch Render to open the Option Box.
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Batch Render GUI
 
Select the render resource to use with the batch render. When choosing Batch render and close or Batch render
Iray will start rendering the current scene as an independet process. The actual settings set in the Render
Settings window will apply to the rendered scene. The log file is by default written to the path where the Maya
preferences and projects are stored. This is by default C:\Users\username\Documents\maya on Windows
and $HOME/maya on Linux. The log file is stored by default in a file named mayaRenderLog.txt.

7.2 Command line rendering
 

This chapter explains the flags specific to Iray for Maya in more detail.
 
Enter the following command in a shell to display a list of all command-line flags for Iray for Maya:
 
To see the available flags for Iray Photoreal:
 
Render -r Iray -help
 
To see the available flags for Iray Interactive:
 
Render -r IrayInteractive -help
 
In the following examples, the scene filename scenename.mb is used as an example of a Maya binary scene file.
 
-of

Defines the output format of the rendered image. Available are jpg, exr, mexr, png, tga, and tif. See
Render settings for a detailed description of the format options.

 
-scale

This flag describes the multiplier for the scaling of the image resolution set in the Render Settings
window. A value of .5 renders half of the resolution set in the Render Globals. A value of 2 doubles the
resolution set in the Render Globals.

 
-percentRes

This flag describes the percentage of the of the image resolution set in the Render Settings window. A
value of 50 renders half of the resolution set in the Render Globals. A value of 200 doubles the resolution
set in the Render Globals.
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-activateRegion
Activate/Deactivate region. This flag overwrites the attribute [Active in the Iray Render Settings ➤ Output ➤
Region].

 
-region

Sets a rendering region of the final image. This flag overwrites the attributes Left, Right, Top and Bottom
in the [Iray Render Settings ➤ Output ➤ Region]. The flag -region always defines a part of the image
relative to the final resolution. -region 0 0.5 0 1 always describes the space (in this case the left part of
the image) in the rendered image independent of the defined resolution.

 
-window

Sets a rendering window of the final image. This flag asks for integer numbers to define the window to
be rendered. The flag -window defines an absolute part of the image. -window 0 99 0 99 always renders
a part of the image with a size of 100 x 100 pixels on the top-left side of the image independent of the
defined resolution.

 
-tiling

This flag allows an easy access to set up a tile rendering. The first two numbers define the number of tiles
the images is splitted. The second two numbers describe the tile to be rendered. For example: -tiling 2 2
1 1 splits the image in 2 horizontal and 2 vertical tiles and renders tile in the upper left corner.

 
-filterRadius

Overrides the size of the pixel sample for the selected Filtering.
 
-minSamples

Specify this flag to overwrite the value set for Min. Samples in the Render Settings window. This value
must be an integer.

 
-maxSamples

Specify this flag to overwrite the value set for Max. Samples in the Render Settings window. This value
must be an integer.

 
-bucketing

Use this option to reduce the memory usage when rendering large image size or lots of framebuffers. The
unit for this option is megapixel.
 

By default Iray for Maya 2.2 will render the full image resolution and all canvases in one step. In some situations
(large image resolution and/or lots of canvases) the given GPU memory will be too small and Iray for Maya 2.2
might fall back in CPU. One way to avoid this is using the new bucket rendering which will be enabled by this
flag. The image will be splitted in smaller pieces (buckets) and will use less memory for the rendered canvases.
 
As a rule of thumb you can calculate with a memory usage of 16 MB for a bucket size of 1 megapixel per canvas
with four used channels (RGBA). If you render e.g. 16 canvases this will be 256 MB of GPU memory in total for a
bucket of 1 megapixel.

 
Note: All calculations are done for a bucket, meaning that caustic sampler, post effects, and
post denoising may and will give different results compared to rendering without bucketing.
 
-intermediateWrite

Use this flag if you want to let Iray for Maya 2.2 write an image after a specified number of samples.
There are different behaviours possible:
 
Default render (no bucketing): Write at predefined number of samples or write after defined steps of
samples.
Bucket rendering: Write after a defined number of buckets of after a specifed percentage of rendered
pixels.
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To get images, for example, after 500, 1250, and 4000 samples for a Maya file named scenename.mb, write:
 
Render -r Iray -intermediateWrite select 500,1250,4000 scenename.mb
 
To get images every 500 samples, write:
 
Render -r Iray -intermediateWrite step 500 scenename.mb
 
If you do not want to overwrite the image for every step written and keep each step as a separate image, use the
following syntax:
 
Render -r Iray -intermediateWrite step 500 -of exr -im imagename_[Sampels:4]
scenename.mb
 
The syntax [Samples:4] sets the number of digits used for the consecutive number of samples. So after
every 500 samples a new image will be written named imagename_0500.exr, imagename_1000.exr,
imagename_1500.exr, and so on.
 
To get an image after every 4 buckets:
 
Render -r Iray -intermediateWrite bucketStep 4 -of exr scenename.mb
 
To get an image after every 18%  of rendered pixels:
 
Render -r Iray -intermediateWrite bucketImage 18 -of exr scenename.mb
 
 
-postDenoiser

This flag enables the postDenoiser. It has three options:
0 = postDenoiser is disabled
1 = postDenoiser is enabled. Only the denoised image is written
2 = postDenoiser is enabled. The original image and the denoised image are written.

 
-fastAnimaton

Only an update of changed objects between frames will be calculated when rendering animations. This
speeds up render time because Iray for Maya 2.2 will not rebuild and load the complete scene for every
single frame. In some situations it might happen that some changes are not recognized by Iray for Maya
2.2 and animations are rendered wrong. In this situation it is necessary to force a complete rebuilt for
every single frame. To do so use the flag -fastAnimation and set the value to 0.
0 = fastAnimation is disabled
1 = fastAnimation is enabled (Iray for Maya 2.2 default behaviour)
 

-maxTime
Specify this flag to overwrite the value set for Max. Time in the Render Settings window. The format is
days hours minutes. Each value must be an integer.

 
-queryR

Print resources. This flag shows the available rendering resources available on the computer and
displays detailed hardware information and the corresponding resource number.

 
-rOff

Disable resource. Use this flag to disable specific render resources identified by the resource number.
 
-rOn

Enable resource. Use this flag to enable specific render resources identified by the resource number.
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-rt

Set active threads. Use this flag to set the number of threads when rendering using CPUs. Make sure
that even one thread is available for each GPU when rendering in mixed mode (GPU and CPU)

 
To see which render resources are used by a scene type, enter:
 
Render -r Iray -queryR scenename.mb
 
The output should look something like this:
 

Resource 0 (disabled):CPUs
Active Threads:12

 
Resource 1 (disabled):  Quadro K5000
Memory:                  4095 MB
Cuda Device Id:          1
Cuda Compute Capability: 0 - 3
Clock Rate:              688 MHz
Multi Processor Count:   8

 
Resource 2 (enabled):   Tesla K20c
Memory:                  5119 MB
Cuda Device Id:          0
Cuda Compute Capability: 5 - 3
 

You can see that the numbering for the different render resources and which resources are used for the
command line rendering and which not. These settings are exactly the one you set in [Window ➤ Rendering
Editors ➤ Iray ➤ Resource Manager].
 
If you want to use all resources for the command line rendering, you have to type:
 
Render -r Iray -rOn 0 -rOn 1 -rOn 2 scenename.mb
 
If you want to use only the GPU resources for the command line rendering, you have to type:
 
Render -r Iray -rOff 0 -rOn 1 -rOn 2 scenename.mb

8 Attribute editor
 

Every transform node and polygonal object has an Iray attribute section in the Attribute Editor. Keep in mind that
these attributes are slightly different. The attributes Steps Per Frame and Rotation Interpolation are only available
in the Attribute Editor of each transform node. The Displacement section is only available in the Attribute Editor of
each shape node.
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Iray section of a transform node
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Iray section of a polygonal shape node
 
 

 
 

 

8.1 Iray attributes
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Iray section of a transform node
 

Light Portal
Yes

Activates the selected area light as light portal. The area light emits no light.
 
No

Deactivates the selected area light as light portal. The area light emits light.
 
Use Inherited

Applies the settings of the Visibility attribute of the parent node.
 
Note:
 

Keep in mind that Portal Light only affects area lights. Light emissive geometry will not
act as light portals. For details, see the section Area Light.

 
Visible

Use Inherited: Applies the settings of the Visibility attribute of the parent node.
 
Visible Yes: Enables the primary visibility of the object.
 
Visible No: Disables the primary visibility of the object. The object is still visible in reflections and
refractions and cast shadow.
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Movable
Use Inherited: Applies the settings of the attribute Movable of the parent node.
 
On: The selected object will be optimized for faster updates when moving the object while Iray is
rendering. Using this flag excessivly can negatively impact rendering performance.
 
Off: The selected object is not optimized for fast updates.

 
Note:
 

The Movable attribute is supported by Iray Photoreal only.
 
Shadow Terminator Offset

Use Inherited: Applies the settings of the Shadow Terminator Offset attribute of the parent nod.
 
On: Iray uses an offset to eliminate self shadowing artifacts know as "Terminator effect" for the
selected object.
 
Off: No offset will be applied to eliminate self shadowing artifacts.
 

Note:
Shadow Terminator Offset in the objects Attribute Editor only has an effect when Shadow
Terminator Offset in the Render Settings is set to User.

 
Handle

Applies an identifier for the geometry. This identifier is required when using a Light Path Expression to
access objects.
 

Object ID
Used to keep the object ID color of the object consistent during an animation.
 

 Use Inherited
Applies the parent nodes integer number as an object ID to the shape node.

 
Automatic

Applies a random integer number as an object ID to the shape node. The number is
generated using the shape name.

 
Set

There are two ways to set the object ID color of the selected object:
•  Apply a defined integer number as an object ID.
•  Click on the color field to open a color chooser to define the color for the selected
object. You can also define a custom color for the alpha channel of the Object ID
canvas.
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Type a number to define a color or click on the color field to open the RGBA Color Chooser.
 

 Use the RGBA Color Chooser to select a color for RGB channels and the Alpha channel of object ID canvas.
 

Note:
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Due to a bug in Maya on Windows OS the color field beside [Object ID ➤ Set]
is getting dark grey after setting the color in the RGBA Color Chooser. You
need to switch the Object ID attribute once and then go back to [Object ID ➤
Set] to see the correct color in the color field.

 
 
 

8.2 Iray attributes: Vertex Color
 
 

Attribute Editor: Iray Vertex Color attribute
 

Vertex Color:
 

When this attribute is enabled Iray for Maya 2.2 is able to process the vertex color information of this
node. This attribute is disabled by default.
 
 

Note:
 

The attribute Vertex Color only delivers information to Iray for Maya 2.2. To see the Vertex
Color while rendering with Iray for Maya 2.2 some more action is necessary. The delivered
information will be collected by ifmState. To make this information visible in Iray for Maya
2.2 ifmState must be connected to an Iray for Maya 2.2 material.
 
 

Example:
 
•  Create a MASH object which is using the MASH_Color node. Use e.g. a Ramp node to add different colors to
the MASH objects.
•  Select the MASH_ReproMeshShape and enable the attribute Vertex Color in the Iray section of the Attribute
Editor.
•  Create an ifmState node and an ifmOpaque material.
•  Conncet the attribute Vertex Color of the ifmState node with the attribute Color of the ifmOpaque material.
•  In the ifmState node set the attribute Vector Color Id to 1
•  Assign the ifmOpaque to the MASH_ReproMesh
•  Create a light and render the scene with Iray for Maya 2.2. Now you see the MASH object with the colors
coming from the MASH_Color node.
 

8.3 Iray attributes: Matte attributes
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Attribute Editor: Iray Matte sub-section
 

 
Enable

Use Inherited
 Applies the settings for the Matte attribute of the parent node:

Yes
Enables the behaviour of the object as matte object. A matte object shows shadows and
reflections only and is apart of that invisible.

No
Disables the matte behaviour of the object

 
Shadow Intensity

Use Inherited
 Applies the settings for this attribute of the parent node

 
Set

Use this attribute to darken or lighten the shadow on the matte object
 

Connect to Environment
Use Inherited

 Applies the settings for this attribute of the parent node
 

Yes
Secondary interactions with the matte object will use the environment instead of the
backplate

 
No

Secondary interactions with the matte object will use the backplate instead of the
environment

 
Note:

Only effective if a backplate function or the backplate color is set.
 
Connect from Camera

Use Inherited
 Applies the settings for this attribute of the parent node

 
Yes

Local effect, where similar interactions with the matte object (for example, the same point
of intersection) will deliver the exact same lookup into the real world photograph, which
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usually works best for a very elaborate matte object setup specifically arranged for only a
single or very similar camera positions.
 

No
Global effect, where the real interactions with the environment or backplate are used
instead, which is usually preferrable for simple matte object setups (like plain shadow
catchers) or full camera interaction.

 
Note:

The attribute Connect from Camera will only be noticable in scenes where no
backplate/color at all is specified (so all interactions will always be happening with the
environment), or if a backplate/color is specified and the Connect to Environment flag is
set in addition.

 

8.4 Iray attributes: Displacement attributes
 

Note:
 

The Displacement subsection is only available when a polygonal shape node is selected.
 

Attribute Editor: Iray Displacement sub-section
 
 

Limit
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Defines the displacement height. Controls the maximum offset, in world units, that can be given to a
vertex when displacing it. This value can affect the bounding box of an object.
 

Method
Parametric

Defines parametric subdivision as method to refine the displacement map. The objects topology
is recursively subdivide to create the displacement effect. Each subdivision recursion potentially
divides a single face into four smaller faces.

 
Length

Defines a topology independent method to subdivide a polygon for displacement mapping.
Defines the smallest potential edge length due to subdivision. Iray stops subdividing an edge
once it reaches this size.

 
Subdivision

This attribute is only valid when Parametric is selected as the displacement method. It defines the
number of subdivisions for the given topology. Increasing this value generates a finer displacement but
also increases rendering time.

 
Length Bound

This attribute is only valid when Length is selected as the displacement method. It defines the maximum
length of a triangle in world space units. Decreasing this value generates a finer displacement but
increases rendering time.

8.5 Iray attributes: Motion Blur attributes
 
Note:
 

The Displacement subsection is only available when a transform node is selected.
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Attribute Editor: Iray Motion Blur sub-section
 

Steps Per Frame
Use Global

Iray for Maya 2.2 takes the values set in the Rendering Settings and applies these values to the
object.
 

Override
Set a per object override for the selected object.

 
A detailed description of the attribute Steps Per Frame can be found in chapter 6.2.5 Motion Blur attributes
 
Rotation Interpolation

Use Global
Iray for Maya 2.2 takes the values set in the Rendering Settings and applies is it to the object.
 

Rotation Value
Set Rotation Value as a per object override for the selected object. A detailed description of the
attribute Rotation Value can be found in chapter 6.2.5 Motion Blur attributes

 
Spherical

Set Spherical as a per object override for the selected object. A detailed description of the
attribute Spherical can be found in chapter 6.2.5 Motion Blur attributes

 

8.6 Iray attributes: Motion Blur for Vertex Animation
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Note:
 

The Vertex Animation subsection is only available when a polygonal shape node is
selected. Motion Blur in the Render Settings window must be enable to get motion blur
for animated vertices.
 

Attribute Editor: Iray Vertex Animation sub-section
 
 
 
 
Animation Source: Vertex Animation
 
When using Lattices, Non-Linear Deformers, etc. to deform and animate a polygon meshes no motion blur will
be calculated by default for the animated vertices. To get motion blur for animated vertices you must enable the
attribute Animation Source.
 

Vertex Animation
Choose Vertex Animation when the movement of vertices is animated by animation curves. This
is the case when using lattices, non-linear deformers, clusters, etc.
 
Steps

Sets the precision for the calculation of the Motion Blur. The higher the value the more
precise the calculation of the vertex movement.

 
 
Animation Source: Motion Vector
 
When you want to render Maya Fluid with Iray for Maya 2.2 you must convert your fluid to a polygon mesh. Maya
generates velocity per-vertex data that can be used to compute motion blur when your fluid is rendered using Iray
for Maya 2.2. Velocity Per Vertex, a fluidShape node attribute, generates data from the fluid object by mapping
fluid velocity values to R, G, and B color values. Velocity Per Vertex is on by default
 
The velocity per-vertex data is passed to the output mesh through the polySurfaceShape node’s color set named
Motion Vector Color Set. By default, this color set uses the velocityPV data generated from the fluid object.
 
To see motion blur in your rendered fluid, ensure that velocityPV is connected with Motion Vector Color Set of the
generated fluid mesh. In the  Iray for Maya 2.2 render options Motion Blur must be enabled.
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Motion Vector

Choose Motion Vector when the movement of the vertices is triggered by a Motion Vector Color
Set.
 
Motion Vector Unit: Per Frame

Choose this setting when the information of the vertex position for the following frame is
stored in the Motion Vector Color Set. This is the default behaviour of e.g. Maya Fluid.
 

Motion Vector Unit: Per Second
Choose this setting when the information of the vertex position is stored on a time base.
This is mostly the case when data is imported from other applications
 

Motion Vector Scale
The scale factor for the Motion Vector Unit: Per Second. Use this scaling factor when the
time unit is different than second to get the proper result for the calculated motion blur.

 
 
 

9 Decal
 
Decals are an Iray specific way to place stickers on materials. The way they work is different than using the
regular Maya tools like Stencil, Layered Texture or Layered Shader. A decal is like an object containing a
projection. A material must be assigned to this object. This material will be projected on to another object. A decal
will stick to an object even this is moved, rotated or scaled.
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Illustration of the ifmDecal function
 

The most common material to be used with a decal is an ifmGeometryModifier. Use the Cutout Opacity attribute
from the ifmGeometryModifier node to define the decal shape. The material assigned to the ifmGeometryModifier
will be showed outside the cutout area.
 

ifmGeometryModifier connected to ifmDecal. This is the corresponding shading network to the illustration showed at the top of the page.
 

To apply a decal to one or more objects, select the objects and select  [Create ➤ Section Object] from the Maya
main menu.
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Decal / Decal instances menu
 
 

Use the Priority attribute to define the order for overlapping decals.
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Decals will stick automatically to objects without the need of a proper UV set. This makes it easy for some kind of animation.
 

9.1 Decal assignment and handling
 

 

Decal / Decal instances menu
 

Decal assignment
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To apply a decal to one or more objects, select the objects and then select  [Create ➤ Decal / Decal Instances]
from the Maya main menu. There are three different ways to select objects and materials in combination with the
menu entry Decal / Decal Instances:
 
1.  Selection of one or more transform nodes: An ifmDecal will be created with two corresponding
ifmDecalTransform nodes and will be instanced under all selected transform nodes.
2.  Selection of one or more transform nodes and exactly one IFM material: Same as 1., but the selected IFM
material will be connected to the ifmDecal node.
3.  Selection of one or more transform nodes and exactly node ifmDecalTransform node: The selected
ifmDecalTransform node will be instanced under all selected transform nodes.
 
There are always two ifmDecalTransform nodes above the ifmDecal. The lower one is instanced. Thus it is
possible to position the decal for all instances in the same way using the lower transform and, if required, a single
instance can be positioned using the upper transform.
 
Decals are best controlled using the menu entry "Decal / Decal Instances" in the "Create" menu, right above
"Section Object". If it is necessary for any reason to change the hierarchy after a ifmDecal is assigned keep the
following in mind:
 
1.  The ifmDecalTransform node should only have own child.
2.  The child of the ifmDecalTransform node has to be either an ifmDecalTransform node or an ifmDecal node.
3.  The parent of an ifmDecal node has to be an ifmDecalTransform node.
 
Materials
 
Materials on decals have a few restrictions:
 
•   Materials are always thin-walled on decals.Front and back-side can have different surface properties. For
example a label on a glass bottle can have the logo printed on the front-side while the back-side has a plain white
paper surface.
•   Decals support cutout opacity and transmissive materials.
•   Emission is not supported.
•   Normal maps are supported.
•   Displacements are not supported.
•   Volume properties are not supported, except that the IOR value is used in valid thin-walled surface material
effects, like in the Fresnel-driven selection between reflection and transmission in the combined specular BSDF.
 
Number of ifmDecal nodes
 
The number of decals whose clip box can overlap at a surface shading point is limited to six. If a decal is
applied on both sides of a surface, it naturally counts twice towards this limit. The number of decals in general is
unlimited.

9.2 Decal attributes
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ifmDecal attributes in the Attribute Editor
Material

This attribute is the same as for any other object, except that decals support only a single material and
not arrays of materials.

 
Face Mode

This attribute controls whether the decal appears on the front face (the default), the back face, or both
faces of the objects surface. The face orientation is determined w.r.t. the projection direction. The normal
derived from the orientation of the geometric primitives is not relevant. For non-thin-walled materials the
decal is never shown on the face with higher density.

 
Priority

This is an integer priority value which is used to resolve the ordering in case of overlapping decals. The
default is 0 and negative values are allowed. A decal with higher priority is placed on top of a decal with
lower priority.

 
Projector

The that defines how the decal is applied to the object. The default setting is Planar. Without a projector
function, the decal will use the uv-coordinates of the object itself, which is the default. This makes the
decal behave more like texturing but with a full material layered on top of the objects material.
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Clipping Box
A clipping box that restricts the effects of the decal. The clipping box is an axis-aligned box defined in the
object space of the decal.

 
UVW Clipping Box

Defines an area in UVW space to restrict the effects of the decal.
 

10 Section Object
 

The Section Object is used to hide parts of objects. The created effect is only visual; the Section Plane does not
affect the geometry. The effect of hidden geometry is only visible in the Render View while rendering with Iray.
 
To create a Section Object go to the main menu [Create ➤ Section Object].
 

Section Object menu
 

A Section Object is a locator shaped like a plane. The plane defines where Iray cuts the visiblity of an object. All
parts along the X+ axis will be invisible while rendering.
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 Section Object locator in the Maya viewport
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Effect of the same Section Object in the Render View

10.1 Section Object attributes
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Section Object attributes in the Attribute Editor
 

 
Enable

Enables or disables the Section Objects impact on the gemeotry.
 
Clip Light

This attribute defines if light will be calculated for the inner parts of the clipped geometry. If it is enabled,
the Section Object will act as a light blocker but it will not cast a shadow.
 

 

Clip Light attribute turned off
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Clip Light attribute turned on
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Enable section capping turned on
Note:

•  Section Objects always affect all objects in the scene.
•  You can use more than one Section Object in a scene.
•  To use section caps go to the Render Settings Iray Common tab and select Enable in the
Section Objects section

 
 

11 Camera
 
Because of some architectural differences between the Maya camera model and the Iray camera model not
every camera attribute is supported by Iray for Maya.
 
Note:

Only the supported attributes are described in this chapter.
11.1 Camera attributes
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Camera attributes
 
 

Controls
Regular Maya behaviour
 

Angle of View
Regular Maya behaviour
 

Focal Length
Regular Maya behaviour
 

Camera Scale
Regular Maya behaviour

11.2 Film back attributes
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Film back attributes
 
 

Film Gate
Regular Maya behaviour
 

Camera Aperture
Regular Maya behaviour
 

Film Aspect Ratio
Regular Maya behaviour
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Film Offset

Regular Maya behaviour

11.3 Depth of Field attributes
 

Iray uses the default attributes coming with the default Maya camera to control Depth of Field, except Focus
Region Scale.
 

Depth of field attributes
 

 
Depth of Field

Enables or disables Depth of Field calculation.
 

Focus Distance
The distance from the camera at which objects appear in sharp focus, measured in the scene's linear
working unit. The valid range is 0 to infinity. The default value is 5.
 

F Stop
Controls the area of sharpness around the value set in Focus Distance. Larger values make this area
bigger.

11.4 Special effect attribute
 

Iray uses the default attribute coming with the default Maya camera to control motion blur.
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Special effect attribute
 
 

Shutter Angle
Controls the blurriness of motion blurred objects. In a real-world camera, the shutter is actually a metal
disk that is missing a pie-shaped section. This disk sits between the lens and the film, and rotates at a
constant rate. When the missing section is in front of the film, it allows light from the lens to pass through
and expose the film. The larger the angle of the pie-shaped section, the longer the exposure time, and
moving objects are more blurred. Shutter Angle is measured in degrees. The valid range is 1 to 360. The
default value is 144. This attribute has no effect until Motion Blur is turn on in the Iray Render Settings.

11.5 Display options
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Camera Display Options
 

All attributes are supported except 2D Pan/Zoom ➤ Render Pan Zoom

11.6 Movement options attributes
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Camera Movement Options
 

All attributes have regular Maya behaviour

11.7 Orthographic views attributes
 



 

180

Camera Orthographic View Options
 

All attributes have regular Maya behaviour

11.8 Image Plane
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Image plane options
 

Iray for Maya 2.2 supports some basic display modes and textures as image planes.
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Supported Display Modes for the Image Plane
 

Display Mode
None and RGB are supported by Iray for Maya 2.2
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Image Plane type Texture
 

Type Texture
All textures supported by Iray for Maya 2.2 can now be used as image plane when the attribute Type
Texture is selected

11.9 Iray section
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Iray section of the camera Attribute Editor

11.9.1 Use Near Clip Plane
 

 Attribute Use Near Clip Plane in the Iray section of the camera Attribute Editor
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Enable this attribute to use the cameras near clipping plane while rendering with Iray. This attribute is off by
default.

11.9.2 Refract Backplate
 

 Attribute Refract Backplate in the Iray section of the camera Attribute Editor
 

Enable this attribute to show the backplate through refractive materials instead of the environment.

11.9.3 Aperture Shape
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Aperture Shape sub-section in the Iray section of the camera Attribute Editor
 

Iray for Maya now supports three different shapes for the aperture shape: Circular, Blade and Custom. The
aperture shape becomes visible when looking into a light source or very bright highlights.
 
Note:

The aperture shape is only visible when Depth of Field is turned on in the Attribute Editor
of the same camera where Aperture Shape is turn on.

 
Type
 

Type Circular
 The aperture shape is set to a circular shape.

 
Type Blade

The aperture shape is set to a n-sided polygonal shape.
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GUI when Aperture Shape ➤ Blade is selected
 

When Type is set to Blade the following attributes are available:
 

Blades
Sets the number of edges of the n-sided polygon.

 
Blade Rotation Angle

Sets the rotation of the n-sided polygonal aperture shape.
 

Type Texture
Use a texture image to define the aperture shape.

 
Note:

This feature is not recognize by the IPR. You need to restart the rendering to see the
texture create an effect.

11.9.4 Lens
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Lens sub-section in the Iray section of the camera Attribute Editor
 

Iray for Maya now supports three different lens types: Planar, Cylindrical and Spherical. Changing the lens type
will affect the resulting image but not the visual feedback in the Maya viewport.

11.9.4.1 Lens Type Planar
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Lens sub-section in the Iray section of the camera Attribute Editor
 
 

Lens Type Planar is the default lens type simulating a regular lens while rendering.
 
When Planar is selected you have the choice to select a distortion type for the planar lens:
 

Distortion Type Linear
No lens distortion is applied to the render result.

 
Note:

The default setting for Lens is Lens Type Planar and Distortion Type Linear. This setting is
the lens behavior as in the previous version of Iray for Maya.
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Lens sub-section in the Iray section of the camera Attribute Editor
 

Lens distortion is used to adjust the perfect computer lens in computer graphics to fit real world camera lenses.
Finding the correct parameters to do so is a complex process and requires expert knowledge. You can find
different websites covering this topic. The exposed attributes are meant for specialists knowing how lens
calibration works and how to convert the calibration results in computer graphics.
 
    The described distortion types controls the radial distortion model. The radial distortion models define the
relationship between the undistorted radial pixel coordinate ru and the distorted radial pixel coordinate rd.
 

Distortion Type Third Order Radial
Third order radial distortion model: rd = ru · (1.0 - k1 + k1 · ru

2)
 

Distortion Type Third Order Inverse Radial
Third order inverse radial distortion model: ru = rd · (1.0 - k1 + k1 · rd

2)
 

Distortion Type Fifth Order Radial
Fifth order radial distortion model: rd = ru · (1.0 + k1 · ru

2 + k2 · ru
4)

 
Distortion Type Fifth Order Inverse Radial

Fifth order inverse radial distortion model: ru = rd · (1.0 + k1 · rd
2 + k2 · rd

4)
 

Distortion Type Fourth Order Radial
Fourth order radial distortion model: rd = ru · (1.0 - k1 - k2 - k3 + k1 · ru + k2 · ru

2 + k3 · ru
3)

 
Distortion Type Fourth Order Inverse Radial
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Fourth order inverse radial distortion model: ru = rd · (1.0 - k1 - k2 - k3 + k1 · rd + k2 · rd
2 + k3 ·

rd
3)

 
Distortion Parameter k1

Controls the parameters k1 in the radial distortion models.
 

Distortion Parameter k2
Controls the parameters k2 in the radial distortion models.

 
Distortion Parameter k3

Controls the parameters k3 in the radial distortion models.
 

Distortion Scale
Controls the relative scale of the lens distortion.

11.9.4.2 Lens Type Spherical
 

Lens sub-section in the Iray section of the camera Attribute Editor
 

Lens Type Spherical renders a conventional spherical camera mapping. When setting the image aspect ratio to
2:1 the resulting image can be used as spherical environment.
 
When Spherical is selected only the position of the camera will influence the resulting image. Focal Lenght, Film
Offset, etc. have no effect to the way the spherical projection is calculated.

11.9.4.3 Lens Type Cylindrical
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Lens sub-section in the Iray section of the camera Attribute Editor
 

Lens Type ➤ Cylindrical renders a conventional cylindrical camera mapping. When Cylindrical is selected Film
Offset will not effect the resulting image.

11.9.5 Stereo rendering for virtual reality
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Virtual Reality sub-section in the Iray section of the camera Attribute Editor
 

In this section a camera can be used to render two images for stereo effects. The difference to the regular Maya
workflow is that no special camera rig is necessary. Stereo renderings can be done using only one camera. To
configure the stereo camera lens following parameters are available:
 
Stereo

Enables stereo rendering for the selected camera.
 
Focus Distance

Defines the distance of the zero parallax.
 
Note:

The attribute Focus Distance is the same attribute as Focus Distance in [Camera ➤ Depth
of Field ➤ Focus Distance]. You have to keep this in mind when using depth of field in
combination with stereo rendering.

 
Eye Separation

Controls the distance between the right and the left camera for stereo view. The attribute refers to the
selected Maya scene units.

 
Set to Default

Sets the value for Eye separation to a distance of 6 cm. This behaviour is independent of the chosen
scene units.

 
 

 
Virtual Reality sub-section in the Iray section of the camera Attribute Editor with Output selected

 
Output

Controls the stereo rendering mode. By default it is set to left which means that only the left camera is
rendered.
 
right

Setting this option to right switches to the right camera.
both

Setting this option to render the right and the left camera at the same time. The output will be two
images named scenename_left.extension and scenename_right.extension.
 

both, write side-by-side
Setting this option to render the right and the left camera at the same time. The output will be one
image containing the left and right camera view placed side-by-side.
 

both, write top-down
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Setting this option to render the right and the left camera at the same time. The output will be one
image containing the left and right camera view placed one above the other. The right camera
view is the top part of the image.
 

Note:
The Output option write side-by-side and write top-down has no effect when exr is
selected in the Render Settings as ouput format. To write the left and write camera as one
image in exr-format, please check chapter 6.1.4 OpenEXR / OpenEXR multilayer section.

 
Note:

Users can still use the Maya stereo camera rig to create content for stereoscopic viewing.
It is not recommended to mix both techniques. Use either one or the other.

11.9.6 Tonemapper
 

Tonemapper sub-section in the Iray section of the camera Attribute Editor
 

In the Iray section of the Attribute editor:
 
None

No tonemapping is used
 
Simple

Use a simplified tonemapping
 
Photographic

Use a a more advanced tonemapping
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11.9.6.1 Simple tonemapper attributes
 

Tonemapper sub-section in the Iray section of the camera Attribute Editor when Simple is selected.
 
 
 

Tonemap Backplate
Enable this attribute to apply tonemapping to the image plane as well.

 
Exposure

Defines the exposure of the overall image.
 
Whitepoint

Whitepoint is a color that will be mapped to ”white” on output, i.e. an incoming color of this hue/saturation
will be mapped to grayscale, but its intensity will remain unchanged.

 
Gamma

The gamma parameter applies a display gamma correction. If the image will be displayed as-is, without
further post-processing by the application, this value should be set to match the displays characteristic,
otherwise disabled by setting to 1.

 

11.9.6.2 Photographic tonemapper attributes
 
The photographic tonemapper converts actual pixel luminances (in candela per square meter) into image pixels
as seen by a camera, applying camera-related parameters (like f-stops and shutter times) for the exposure, as
well as applying tonemapping that emulates film- and camera-like effects.
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Tonemapper sub-section in the Iray section of the camera Attribute Editor when Photographic is selected.
 
 
 

Tonemap Backplate
Enable this attribute to apply tonemapping to the image plane as well.
 
Film Iso

Film_Iso should be the ISO number of the film, also known as “film speed”.
 
Note:

•  If Film Iso is set to nonzero, Photographic Tonemapper works in “Photographic”-
Mode - in which it assumes input values are (or can be converted to) candela per
square meter.
•  If Film Iso is set to zero, Photographic Tonemapper works in “Arbitrary”-Mode - in
which scene pixels are not considered to be in any particular physical unit, but are
simply scaled by a factor to fit in the display range of the screen.

cm2 Factor
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Note:

This attribute change its behaviour dependent on the setting for the attribute Film
ISO

 
•  In “Photographic"-Mode the attribute cm2 Factor is the conversion factor between pixel values and
candela per square meter.
•  In “Arbitrary”-Mode, cm2 Factor is simply the multiplier applied to scale rendered pixel values to screen
pixels.

 
Whitepoint

Whitepoint is a color that will be mapped to “white” on output, i.e. an incoming color of this hue/saturation
will be mapped to grayscale, but its intensity will remain unchanged.

 
Camera Shutter

This is the camera shutter time expressed as fractional seconds. A value of 1 means 1 second, value of
100 defines a camera shutter of 1/100 and a value of 0.1 defines a camera shutter of 10 seconds. This
value has no effect in “Arbitrary” mode.
 

f-Number
This is the fractional aperture number. For example, “11” defines aperture “f/11”. Aperture numbers on
cameras go in a specific standard series: f/8, f/11, f/16, f/22, and so forth. Each of these are referred to
as a “stop” (from the fact that aperture rings on real lenses tend to have physical “clicks” for these values)
and each such “stop” represents halving the amount of light hitting the film per increased stop2. This
value has no effect in “Arbitrary” mode.

 
Vignetting

In a real camera the angle with which the light hits the film impacts the exposure, causing the image to
go darker around the edges. The vignetting parameter simulates this. At 0.0 it is disabled, higher values
cause stronger darkening around the edges. Note that this effect is based on the cosine of the angle with
which the light ray would hit the film plane, and is hence affected by the field-of-view of the camera, and
will not work at all for orthographic renderings. A good default is 3.0, which is similar to what a compact
camera would generate.

 
Note:

The parameters Crush Blacks and Burn Highlights guide the actual “tone mapping”
process of the image, i.e., exactly how the high dynamic range values are adapted to fit
into the black-to-white range of current display devices.
 
If Burn Highlights is set to one and Crush Blacks to zero, the transfer is linear, that is, the
mapping behaves like a simple linear intensity scaler only.

 
Crush Blacks

When the upper part of the dynamic range becomes compressed it naturally loses some of it's former
contrast, and one often desires to regain some “punch” in the image by using the Crush Blacks
parameter. When 0, the lower intensity range is linear, but when raised towards 1, a strong “toe” region is
added to the transfer curve so that low intensities get pushed more towards black, but in a gentle fashion.
 

Burn Highlights
Burn Highlights can be considered the parameter defining how much “over exposure” is allowed. As it is
decreased from 1 towards 0, high intensities will be more and more “compressed” to lower intensities.
When it is 0, the compression curve is asymptotic, i.e. an infinite input value maps to white output value,
i.e. over-exposure is no longer possible. A good default value is 0.5.
 

Burn Highlights Per Component
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Specifies how the Burn Highlights parameter is applied to the different color components. By default it
is applied separately to all channels, which can lead to saturation loss though. Disabling the parameter
applies the Burn Highlights to the luminance, keeping the output color as close as possible to the input
color.

 
Saturation

Compressing bright color components inherently moves them towards a less saturated color. Sometimes,
very strong compressions can leave the image in an unappealingly de-saturated state. The saturation
parameter allows an artistic control over the final image saturation. 1.0 is the standard “unmodified”
saturation, higher increases and lower decreases saturation.
 

Gamma
The gamma parameter applies a display gamma correction. If the image will be displayed as-is, without
further post-processing by the application, this value should be set to match the displays characteristic,
otherwise disabled by setting to 1.

12 Environment lights
 

There are two type of environment lights supported by Iray for Maya 2.2: Image Based Lighting and Physically
Sun and Sky. The corresponding nodes are ifmImageBasedLighting and ifmHosekSkylight.

12.1 ifmImageBasedLighting
 

There are two ways to create an ifmImageBasedLighting node:
 
1.   Go to the Maya main menu Create ➤ Lights and select the light you want from the Iray section.
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Maya main menu to create environment lights
 

2.  Alternatively, open the Hypershade and go to the Iray entry. There you will find a section named Lights. Click
on ifmImageBasedLighting to create the node.
 

Create Render Node window to create environment lights
 
Note:

You can create more than one Iray for Maya IBL-node in the scene and use them for
lighting effects.
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Attributes of the ifmImageBasedLighting node in the Attribute Editor
 

 
 

 
 

 
 

 
 

12.1.1 General attributes
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General section of the ifmImageBasedLighting node
 

Image Name
Select the image name to be used for Image Based Lighting. The image must be in OpenEXR format and
must have an image aspect ratio of 2:1.
 

Flip Image
Flips the select image used by the Iray for Maya IBl-node horizontally.
 

Exposure
Sets the exposure for the selected image used by the Iray for Maya IBl-node.
 

Light Burst Threshold
Sets a threshold value which defines the influence of the Attribute "Light Burst Gain"
 

Light Burst Smoothing
Interpolates the transition area of the threshold value to avoid bending effects the may occur.

 
Light Burst Gain

Sets the exposure for the pixels which are defined by the threshold value set by the Attribute "Light Burst
Threshold"

 
Color

Multiplies the selected color by the pixel values of the exr-image used by the Iray for Maya IBl-node.

12.1.2 Display attributes
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Display section of the ifmImageBasedLighting node
 
 

Radius
Sets the Radius for the Iray for Maya-IBL manipulator visible in the viewport. This attribute doesn't effect
the rendering result.
 

Precision
Sets the resolution for the image visible in the Maya viewport. This attribute doesn't effect the rendering
result but may decrease the performance in the Maya-viewport.
 

Gamma
Sets the gamma value for the image visible in the Maya viewport. This attribute doesn't effect the
rendering result. Use this attribute to match the image look in the viewport like in the Render View when
using the Render View Parameter.

12.2 ifmHosekSkylight
 

Iray for Maya 2.2 uses a daylight system based on the Hosek skylight model. The ifmHosekSkylight node is
designed as a light emitter. It can be used as a background environment as well but it wasn't meant to behave
like this. You can use the ifmHosekSkylight model in combination with the ifmSolarConfiguration node to
place the sun for a specific place, date and time. For more information on solar configuration, see the section
“ifmSolarConfiguration”
 
There are two ways to create an ifmHosekSkylight node:
 
1.  Go to the Maya main menu Create  ➤ Lights and select the light you want from the Iray section.
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Maya main menu to create environment lights
 

2.  Alternatively, open the Hypershade and go to the Iray entry. There you will find a section named Lights. Click
on ifmHosekSkylight to create a node.
 

Create Render Node window to create environment lights
 

 
Note:

You can create more than one ifmHosekSylight node in the scene and use them for
lighting effects.
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Attributes of the ifmHosekSkylight node in the Attribute Editor
 

 
 

12.2.1 Sun attributes
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Sun section of the ifmHoskeSkylight node
 
Intensity

Sets the intensity of the sun. The default value of 1. In combination with the default value for Surface
Temperature this gives a realistic sun simulation.

 
Surface Temperature

Defines surface temperature of the sun in Kelvin. The default value is 5788 which is the correct value of
our sun.
 

Elevation
Defines the vertical position of the sun in degree. Setting this to 0 aligns the middle of the sun with the
horizon. Setting this to 90 the sun is perpendicular to the ground.
 

Azimuth
Defines the horizontal position of the sun in degree. When setting this attribute to 0 the sun will shine
from the +X axis to the -X axis when the Maya World Coordinate System is set to Up axis: Y.
 

Add solar configuration
Connects the solar configuration node to the ifmHosekSkylightShape. The solar configuration node
sets the sun position to a specified location and daytime. For more information, see the section
“ifmSolarConfiguration”

12.2.2 Planet attributes
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Planet section of the ifmHoskeSkylight node
 

Turbidity
This attributes defines the haziness of the atmosphere.

 
Ground Albedo

Defines the color of the ground and so the color of the bouncing light.
 
Horizon
    Adjust the horizon height.
 
Horizon Blur

Adjust the interpolation between the horizon and sky.

12.2.3 Advanced attributes
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Advanced section of the ifmHoskeSkylight node
 

Exposure
Sets an additional exposure to the sun and sky simulation.
 

Saturation
Modifies the saturation of the lighting effect. When set to 0, the lighting effect contains no color.
 

Color
 Adds the selected color to sun and sky simulation.
 

Sun
Turns the appearance and effect of the sun on or off.
 
Sky

Turns the appearance and effect of the sky on or off.
 

Sun Blur
Defines the softness of the sun.

 
Color Model

Sets the color model in which the spectral values are calculated.
 
RGB Space

Sets the color space in which the spectral values are translated.
 

12.2.4 Display attributes
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Display section of the ifmHoskeSkylight node
 

Radius
Sets the Radius for the Iray for Maya 2.2 IBL manipulator visible in the viewport. This attribute doesn't
effect the rendering result.

 
Precision

Sets the resolution for the image visible in the Maya viewport. This attribute doesn't effect the rendering
result but may decrease the performance in the Maya-viewport.
 

Gamma
Sets the gamma value for the image visible in the Maya viewport. This attribute doesn't effect the
rendering result. Use this attribute to match the image look in the viewport like in the Render View when
using the Render View Parameter.

13 Maya standard lights
 
 
 

Iray for Maya 2.2 supports the standard Maya lights Directional Light, Point  Light, Spot Light and Area Light. Due
to technical reasons not all attribures are available when rendering with Iray for Maya 2.2.

13.1 Directional Light
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Gargoil lit by standard Directional Light
 

Create a standard Maya Directional Light from the main menu Create ➤ Lights ➤ Directional Light.
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Directional Light Attributes section in the Attribute Edtior of the Maya Directional Light
 
 

13.1.1 Directional light attributes
 

The attributes supported by Iray for Maya 2.2 are Color and Intensity. All other attributes in the Directional Light
will be ignored by Iray.
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Attributes in the Attribute Edtior of the Maya Directional Light
 
Color

Adjust the color of the emitted light.
 

Intensity
Adjust the intensity of the emitted light.
 

Note:
Directional Lights in Maya have no light decay. This is different in Iray for Maya because
in reality light always has a decay over the distance. A Directional Light rendered with
Iray for Maya always has light decay. So it is necessary to increase the intensity of the
Directional Light to see any lighting effect.

 
Note:

Directional Lights rendered with Iray for Maya 2.2 will only cast hard shadows.
 

13.1.2 Iray attributes
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Attributes in the Attribute Edtior of the Maya Directional Light
 
Handle

Applies an identifier for the light. This identifier is required when using a Light Path Expression to access
objects.

13.2 Point Light
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Gargoil lit by standard Point Light
 

Create a standard Maya Point Light from the main menu Create ➤ Lights ➤ Point Light.
 



 

180

Point Light Attributes section in the Attribute Edtior of the Maya Point Light
 

13.2.1 Point light attributes
 

The attributes supported by Iray for Maya 2.2 are Color and Intensity. All other attributes in the Point Light will be
ignored by Iray.
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Attributes in the Attribute Edtior of the Maya Point Light
 
Color

Adjust the color of the emitted light.
 
Intensity

Adjust the intensity of the emitted light.
 
Note:

Point Lights in Maya are able to send out light without light decay. This is different in Iray
for Maya because in reality light always has a decay over the distance. So it is usually
necessary to increase the intensity of the Point Light to see any lighting effect.

 
Note:

Point Lights rendered withIray for Maya 2.2 will only cast hard shadows.
 

13.2.2 Iray attributes
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Attributes in the Attribute Edtior of the Maya Point Light
 

Handle
Applies an identifier for the light. This identifier is required when using a Light Path Expression to access
objects.

13.3 Spot Light
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Gargoil lit by standard Spot Light
 

Create a standard Maya Spot Light from the main menu Create ➤ Lights ➤ Spot Light.
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Spot Light Attributes section in the Attribute Edtior of the Maya Spot Light

13.3.1 Spot light attributes
 
The attributes supported by Iray for Maya are Color, Intensity, Cone Angle and Dropoff. All other attributes in the
Spot Light will be ignored by Iray.
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Spot Light Attributes section in the Attribute Edtior of the Maya Spot Light
 
Color

Adjust the color of the emitted light
 
Intensity

Adjust the intensity of the emitted light
 

Note:
Spot Lights in Maya are able to send out light without light decay. This is different in Iray
for Maya because in reality light always has a decay over the distance. So it is usually
necessary to increase the intensity of the Spot Light to see any lighting effect.

 
Cone Angle

Defines the angle (in degrees) from the edge to the edge of the spot light's beam.
 
Dropoff

Controls the rate at which light intensity decreases from the center to the edge of the spot light beam.
 
Note:

Spot Lights rendered with Iray for Maya 2.2 will only cast hard shadows.
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13.3.2 Iray attributes
 

Spot Light Attributes section in the Attribute Edtior of the Maya Spot Light
 

Handle
Applies an identifier for the light. This identifier is required when using a Light Path Expression to access
objects.

13.4 Area Light
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Gargoil lit by standard Area Light
 

Create a standard Maya Area Light from the main menu Create ➤ Lights ➤ Area Light.
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Area Light Attributes section in the Attribute Edtior of the Maya Area Light

13.4.1 Area light attributes
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Area Light Attributes section in the Attribute Edtior of the Maya Area Light
 

The attributes supported by Iray for Maya are Color and Intensity.
 
Color

Adjust the color of the emitted light
 
Intensity

Adjust the intensity of the emitted light
 
Note:
Area Lights in Maya are able to send out light without light decay. This is different in Iray for
Maya because in reality light always has a decay over the distance. So it is usually necessary to
increase the intensity of the Area Light to see any lighting effect.
 
Note:

Area Lights rendered with Iray for Maya 2.2 will only cast hard shadows.
 

13.4.2 Iray attributes: Light Portal
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A typical problem with architectural scenes is that environment light can sometimes only enter through few
small openings, such as small windows. In cases like this the convergence can often be improved by giving the
renderer a hint where these openings are in the scene.
 
For Iray Photoreal this can be done by placing an arealight over the openings and marking them as light portals
using the attribute Light Portal in the Iray section of the placement node of the arealight
 
Technically, these lights are no longer light sources (they are acting no longer as a light emitter), but merely a hint
to Iray Photoreal where to expect environment light from.
 
Using light portals should not change the rendering result, only convergence speed. However, it should be stated
that they do not always help, in fact they can cause lower performance if placed incorrectly. For an architectural
scene a rule of thumb for using portals is:
 
A significant amount of illumination comes through the windows.

•  The illumination coming through the windows is not dominated by direct sun light or other very bright
regions in the environment.
•  The windows are relatively small.
•  The caustic sampler is enabled.

 
Note:

Light Portals work only with the standard area light. The don't work with light emitting
geometry.
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Area Light Attributes section in the Attribute Edtior of the Maya Area Light
 

Light Portal
Use this attribute to control the portal light functionality. Switches the area light to a light portal

 
 Light Portal Yes

  Activates the selected arealight as light portal. The arealight emits no light.
 
Light Portal No

Deactivates the selected arealight as light portal. The arealight emits light.
 

Light Portal Use Inherited
Applies the settings of the Visibility attribute of the parent node.

 
 

13.4.3 Visible
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Area Light Attributes section in the Attribute Edtior of the Maya Area Light
 
 
 

Visible
Select one of the following attribute values:

 
Use Inherited

Applies the settings of the Visibility attribute of the parent node.
 

Visible Yes
Enables the primary visibility of the object.
 

Visible No
Disables the primary visibility of the object. The object is still visible in reflections and refractions
and cast shadow.

 
 

13.4.4 Material ID
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Area Light Attributes section in the Attribute Edtior of the Maya Area Light
 
 

Material ID
Sets the Material ID for the Area Light. See the section  Material ID for more a more detailed description.

13.4.5 Handle
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Area Light Attributes section in the Attribute Edtior of the Maya Area Light
 
 

Handle
Applies an identifier for the light. This identifier is required when using a Light Path Expression to access
objects.

14 Iray for Maya Materials
 

All shading nodes used by Iray for Maya 2.2 are referred as materials. For this reason you find in this chapter
also shading nodes which may referred as Utilities in the Maya terminology.
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Create Render Node window to acces all  Iray for Maya 2.2 shading nodes

14.1  Materials
 

The Iray for Maya 2.2 materials are designed to create the basic appearance of surfaces. They define the general
specification like reflection characteristics, transparency, index of refraction and so on.
 
The Iray for Maya 2.2 material ifmMDLMaterial is an exception. It will be used to add MDL materials from a
given MDL library or exported from other applications using Iray. Usually MDL materials are made to get the look
and feel of a specific material like e.g. scratched chrome. To create a MDL material you need to write your own
material description or you use an exported material from third-party software. For further information about MDL,
refer to the MDL Handbook provided by Nvidia.
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Create Render Node window to create Iray for Maya 2.2 materials

14.1.1 ifmBackscatter material
 

ifmBackscatter material with different attribute settings. The attribute Roughness on the left material is set to 0
 

Use the ifmBackscatter material when you want light to reflect back to the emitter, rather than following the
standard reflection direction. This effect plays an important role in the simulation of fabrics.
 
Set material attributes in the Attribute editor window:
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ifmBackscatter material attributes
 

14.1.1.1 Backscatter attributes
 

Backscatter section of the material Attribute Editor
 
 

Color
The diffuse and main color of the material.

 
Roughness

The roughness of the surface. A value of 0 describes a plain, smooth, and reflective surface; a value of 1
describes a rough and dull surface. In this particular case a value of 0 shows the incoming lighting from
the opposite side of the visible surface.
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14.1.1.2  Anisotropy attributes
 

Anisotropy ection of the material Attribute Editor
 
 

Anisotropy
Turns anisotropy on or off. The geometry needs useful UV-coordinates to show the result. The values
scales the anisotropic effects along the V-direction of the UV texture coordinates.
 

Rotation
Rotates the anisotropic effects in UV texture coordinates. A value of 1 describes a rotation of 360
degrees.

14.1.1.3  Bump attributes
 

Bump section of the material Attribute Editor
 
 

Bump Map
Add a bump map to the material.

14.1.1.4 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.1.2 ifmBsdf
 



 

180

ifmBsdf rendered with Silver_carpaint.brdf, Gold_carpaint.brdf and Blue_carpaint.brdf (from left to right)
[0x1] Software und Consulting GmbH developed a method for measuring isotropic materials and made this
measurement data available for production rendering. The measurement captures all aspects of light interaction
with the material from different angles. The results is a physical plausible carpaint material showing a superior
quality.
 
Use the ifmBsdf material to take advantage of this technology. In the installation directory of Iray for Maya 2.2 you
find a folder named bsdfs. This folder contains 6 different measured carpaint data sets. Unlike MDL-materials,
these file can be located in any other directory as well.
 
Use material ifmBsdf to render measured carpaint or other isotropic materials measured by [0x1].  Using the
default settings ifmBsdf interpreted the measurement data as is. It doesn't add effects like metallic flakes. The
measure data can be modified using the attributes as described in this chapter.
 
Note: If you want to get a measurement of a custom material and render it with Iray for Maya 2.2
please contact sales@0x1-software.com.
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ifmBsdf material attributes
 
 

14.1.2.1 Main attributes
 

Main attributes of the ifmBsdf material
 

BSDF
Assign the measured data set here. Keep in mind that only data sets provided by [0x1] will work with
ifmBsdf.

 
Scale
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In some rare situation the measured data appear too dark or too bright. Use the Scale attribute to lighten
or darken the measurement data. This attribute acts like an multiplier.

14.1.2.2 Base attributes
 

Base attributes of the ifmBsdf material
 

Color Gain
Use this attribute to modify the appearance of the measured color. This attribute acts like a multiplier to
every single color channel. Use this attributen to adjust the color of the measurement.

 
Bump Map

Add a bump map to the material.

14.1.2.3 Clear Coat attributes
 

Clear Coat attributes of the ifmBsdf material
 

Weight
The amount of specular weight of the clear coat. A value of 0 shows no specular reflection. A value of 1
shows the full specular reflections.
 

Refraction Index
The value sets the index for the specluar reflection of the clear coat layer. Use a value between 1.4 and
1.6 for the most common carpaint materials.
 

Note
The correct value for the refraction index of each individual measurement is hidden in
the measured data. You will get the correct value when rendering the ifmBsdf material the
first time.  Check Mayas Output Window to get the measured refraction index and apply
this value to the Refraction Index attribute.
 

Roughness
The appearance of the specular reflection. A value of 0 describes a plain, smooth and highly reflective
surface; a value of 1 describes a rough and dull surface.
 

Bump Map
Add a bump map to the material. You can use this e.g. to add an orange peel effect to the carpaint.
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14.1.3 ifmBsdfMetallicFlakes
 

ifmBsdfMetallicFlakes rendered with Silver_carpaint.brdf, Gold_carpaint.brdf and Blue_carpaint.brdf (from left to right)
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ifmBsdfMetallicFlakes rendered with no metallic flakes                                          
                                  ifmBsdfMetallicFlakes rendered with blended metallic flakes
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ifmBsdfMetallicFlakes rendered with masked metallic flakes                                       
            ifmBsdfMetallicFlakes rendered with masked metallic flakes and orange peel

 
[0x1] Software und Consulting GmbH developed a method for measuring isotropic materials and made this
measurement data available for production rendering. The measurement captures all aspects of light interaction
with the material from different angles. The results is a physical plausible carpaint material showing a superior
quality.
 
Use the ifmBsdfMetallicFlakes material to take advantage of this technology. In the installation directory of Iray
for Maya 2.2 you find a folder named bsdfs. This folder contains 6 different measured carpaint data sets. Unlike
MDL-materials, these file can be located in any other directory as well.
 
Use material ifmBsdfMetallicFlakes to render measured carpaint or other isotropic materials measured by [0x1]. 
Using the default settings ifmBsdfMetallicFlakes interpreted the measurement data as is. This material adds non-
measured effects like metallic flakes and orange peel. The measure data can be modified using the attributes as
described in this chapter.
 
Note: If you want to get a measurement of a custom material and render it with Iray for Maya 2.2
please contact sales@0x1-software.com.
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ifmBsdfMetallicFlakes material attributes

14.1.3.1 Main attributes
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Main attributes of the ifmBsdfMetallicFlakes material
 

BSDF
Assign the measured data set here. Keep in mind that only data sets provided by [0x1] will work with
ifmBsdfMetallicFlakes.

 
Scale

In some rare situation the measured data appear too dark or too bright. Use the Scale attribute to lighten
or darken the measurement data. This attribute acts like an multiplier.

14.1.3.2 Base attributes
 

Base attributes of the ifmBsdfMetallicFlakes material
 

Color Gain
Use this attribute to modify the appearance of the measured color. This attribute acts like a multiplier to
every single color channel. Use this attributen to adjust the color of the measurement.

 
Bump Map

Add a bump map to the material.

14.1.3.3 Artificial Metallic Layer
 

Artificial Mettalic Layer attributes of the ifmBsdfMetallicFlakes material
 

 
Textured Flakes Mode

Defines if and how the flakes are added to the measured data:
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No Flakes: No flakes are added.

 
Masked Flakes: Flakes are added to the measured data. This method separates the flakes and the
measured data. Imagine a black and white mask that shows the flakes in the white parts and the
measured data in the black parts. The shape of this mask is defined by a procedural texture which can be
modified in the Flakes section.

 
Blended Flakes: Flakes are added to the measured data. This method blends the flakes on the
measured data. The flakes are added as a highlight on top of the measured data. The shape of the flakes
are defined by a procedural texture which can be modified in the Flakes section.

 
Weight

The amount of metallic flake weight. A value of 0 shows no specular reflection. A value of 1 shows only
the metallic flake reflections.

 
Mode

The metallic flake reflection of the material. Select one of the following attribute values:
 

Constant: The metallic flake reflection of the material is angle independent.
 

Curve: The metallic flake reflection of the material is defined by a custom curve, defined by:
•  At 0 Degree:

•  metallic flake reflection for angle of incidence normal to the surface.
•  At 90 Degree:

•  metallic flake reflection for angle of incidence at 90 degrees to surface normal.
•  Exponent:

•  Describes the transition between the values set at the attributes  at 0 degrees and at 90
degrees. It is the exponent for Schlick's approximation.

 
Fresnel: The metallic flake reflection of the material is defined by the Fresnel term.

•  Refraction Index:
•  The refraction taken into account by the Fresnel term to define the metallic flake
reflection. The attribute is defined using a float to describe the Fresnel Index.

 
Fresnel (Advanced): Same behaviour as Fresnel.

•  Refraction Index:
•  The refraction taken into account by the Fresnel term to define the specular reflection.
The attribute is defined using a color. So for each channel R,G,B a different values for the
Fresnel Index are possible.

Color
The specular color of the metallic flakes.
 

Type
This attribute sets the distribution function for the specular light interaction. The default function is named
Simple and is the only one used by older versions of ifmOpaque.
For advance uses, such as matching another implemantation, Iray for Maya 2.2 provides the following
alternative distribution functions for glossy interactions.
The alternate functions are:

•  Microfacet Beckmann Smith
•  Microfacet GGX Smith
•  Microfacet Beckmann v-cavaties
•  Microfacet GGX v-cavaties
•  Microfacet Geisler Moroder

 
Roughness
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The appearance of the specular reflection. A value of 0 describes a plain, smooth and highly reflective
surface; a value of 1 describes a rough and dull surface.

14.1.3.3.1 Flakes
 

Flakes attributes of the ifmBsdfMetallicFlakes material
 

Coordinate System
Defines in which coordinate system the ifmFlakeNoise will be displayed.

 
•  Object:

•  Specifies to position the texture in object space. This effects mainly the scaling of the texture.
When object space is valid the texture size sticks to the scaling factor of the object.

•  World:
•  Specifies to position the texture in world space. When world space is valid the texture size is
independent of the scaling factor of the object.

•  UV:
•  Specifies to position the texture in UV space.

Size
Size of the biggest feature of the pattern
 

Noise Type
Choose between Worley or Classic to define the look of the flake shape.
 

Metric (only available when Worley is selected as Noise Type)
Defines the shape of the flake patterns features.

 
•  euclidean:

•  Defines a more regular shape of the single flake shape.
•  manhattan:

•  Defines a more irregular shape of the single flake shape.
•  chebyshev:

•  Defines a specific shape of the single flake shape using Chebyshev's sum inequality.
 
Maximum Size (only available when Worley is selected as Noise Type)

Controls the shape of flakes when Worley is selected.
 

Intensity
Specifies the maximum reflectivity of any flake.

 
Density

 Controls the amount of flakes in the substrate. the higher the number, the bigger is the space between
flakes.
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Bump Depth
Defines an imaginery depth. Lower values let flakes appear more equally bright, as if the are on one
level. Higher values let the flakes appear differently bright, as if they are deeper in the volume.

14.1.3.4 Clear Coat attributes
 

Clear Coat attributes of the ifmBsdf material
 

Weight
The amount of specular weight of the clear coat. A value of 0 shows no specular reflection. A value of 1
shows the full specular reflections.
 

Refraction Index
The value sets the index for the specluar reflection of the clear coat layer. Use a value between 1.4 and
1.6 for the most common carpaint materials.
 

Note
The correct value for the refraction index of each individual measurement is hidden in the
measured data. You will get the correct value when rendering the ifmBsdfMetallicFlakes
material the first time. Check Mayas Output Window to get the measured refraction index
and apply this value to the Refraction Index attribute.
 

Roughness
The appearance of the specular reflection. A value of 0 describes a plain, smooth and highly reflective
surface; a value of 1 describes a rough and dull surface.
 

Bump Map
Add a bump map to the material. You can use this e.g. to add an orange peel effect to the carpaint.

14.1.3.4.1 Orange Peel
 

Orange Peel attributes of the ifmBsdf material
 

 
Strength

Defines the bump depth of the procedual orange peel pattern.
 
Size

Size of the biggest feature of the orange peel pattern.
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Coordinate System

Defines in which coordinate system the orange peel pattern will be displayed.
 

•  Object:
•  Specifies to position the texture in object space. This effects mainly the scaling of the texture.
When object space is valid the texture size sticks to the scaling factor of the object.

•  World:
•  Specifies to position the texture in world space. When world space is valid the texture size is
independent of the scaling factor of the object.

•  UV:
•  Specifies to position the texture in UV space.

14.1.4 ifmMDLMaterial material
 

ifmMDLmaterial with different Nvidia vMaterials assigned
 

NVIDIA Material Definition Language (MDL) is a domain-specific programming language that defines physical
material properties to serve the separation of appearance description and software implementation required
by current rendering technologies. Use the ifmMDLMaterial to access MDL materials coming from third-party
products or external libraries. You can download the Nvidia vMaterial MDL library from the Nvidia web-site. This
material libraries contains pre-defined
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ifmMDLmaterial with selected MDL material and displayed attributes
 

 
 
For further information about MDL, refer to the MDL Handbook provided by Nvidia.

14.1.4.1 MDL material location
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ifmMDLmaterial material with MDL folders
 
MDL materials can be accessed on three predefined locations. By default these locations are:
 
SYSTEM:

All MDL materials installed by the NVIDIA MDL Material Exchange package to grant compatibilty
between different packages using Iray and MDL. By default this folder is: C:\ProgramData\NVIDIA
Corporation\mdl

 
Note:

You see this folder only if the NVIDIA MDL Material Exchange package is installed. It is
strictly recommended not to delete files in this folder. It is not recommended to rename
this folder or to move it to another location.

 
USER:

This is the place where users can place their own MDL files. By default this folder is: C:\Users
\USERNAME\Documents\mdl
 

PLUGIN:
This is the default installation path of Iray for Maya 2.2. By default this folder is: C:\Program Files
\NVIDIA Corporation\Iray for Maya 2017\materialLibraries

 
 
Click on the tree view in the Attribute Editor and open the folder to get a MDL material. Once you select the MDL
material the exposed attributes appear.
 
Note:

Avoid having multiple MDL materials using the same name in the different folders. Each
MDL material must have a unique name to prevent confusion.
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For details about the displayed attributes, refer to the documentation of the loaded library. These libraries and the
associated documentation are not part of Iray for Maya 2.2.

 
Note:

The ifmMDLmaterial replaces the ifmCustomMDL material introduced with Iray for Maya
2014. Scenes from older version will get an empty node after loading. To rebuild your
scene and migrate to the new ifmMDLMaterial we provide an environment variable to use
both nodes parallel. We strictly recommend to enable this function only for conversion
reasons. The ifmCustomMDL node will be erased in the next version of Iray for Maya. Set
the environment variable IFM_LEGACY_CUSTOMMDL=enable to get access to the old
ifmCustomMDL node.
 

For further information about MDL, refer to the MDL Handbook provided by Nvidia.

14.1.4.2 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.1.5 ifmOpaque material
 

ifmOpaque material with different attribute settings
 

Use the ifmOpaque material to render opaque materials such as plastic, metal, stone, and wood. Set material
attributes in the Attribute Editor window.
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ifmOpaque material attributes

14.1.5.1 Diffuse attributes
 

Diffuse section of the ifmOpaque material
 
 

Color
The diffuse and main color of the material.
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Roughness

The roughness of the surface. A value of 0 describes a plain, smooth and reflective surface, a value of 1
a rough and dull.

14.1.5.2 Specular attributes
 

Specular section of the ifmOpaque material
 

Weight
The amount of specular weight. A value of 0 shows no specular reflection. A value of 1 shows only the
specular reflections.

 
Mode

The specular reflection of the material. Select one of the following attribute values:
 

Constant: The specular reflection of the material is angle independent.
 

Curve: The specular reflection of the material is defined by a custom curve, defined by:
•  At 0 Degree:

•  Specular reflection for angle of incidence normal to the surface.
•  At 90 Degree:

•  Specular reflection for angle of incidence at 90 degrees to surface normal.
•  Exponent:

•  Describes the transition between the values set at the attributes Specularity at 0 degrees
and Specularity at 90 degrees. It is the exponent for Schlick's approximation.

 
Fresnel: The specular reflection of the material is defined by the Fresnel term.

•  Refraction Index:
•  The refraction taken into account by the Fresnel term to define the specular reflection.
The attribute is defined using a float to describe the Fresnel Index.

 
Fresnel (Advanced): Same behaviour as Fresnel.

•  Refraction Index:
•  The refraction taken into account by the Fresnel term to define the specular reflection.
The attribute is defined using a color. So for each channel R,G,B a different values for the
Fresnel Index are possible.

Color
The specular color of the material.

 
Type

This attribute sets the distribution function for the specular light interaction. The default function is named
Simple and is the only one used by older versions of ifmOpaque.
For advance uses, such as matching another implemantation, Iray for Maya 2.2 provides the following
alternative distribution functions for glossy interactions.
The alternate functions are:
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•  Microfacet Beckmann Smith
•  Microfacet GGX Smith
•  Microfacet Beckmann v-cavaties
•  Microfacet GGX v-cavaties
•  Microfacet Geisler Moroder

 
Roughness

The appearance of the specular reflection. A value of 0 describes a plain, smooth and highly reflective
surface; a value of 1 describes a rough and dull surface.

14.1.5.3  Anisotropy attributes
 

Anisotropy ection of the material Attribute Editor
 
 

Anisotropy
Turns anisotropy on or off. The geometry needs useful UV-coordinates to show the result. The values
scales the anisotropic effects along the V-direction of the UV texture coordinates.
 

Rotation
Rotates the anisotropic effects in UV texture coordinates. A value of 1 describes a rotation of 360
degrees.

14.1.5.4 Bump attributes
 

Bump section of the material Attribute Editor
 
 

Bump Map
Add a bump map to the material.

14.1.5.5 Miscellaneous attributes
 
 

Misc ection of the material Attribute Editor
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Material ID

See the section The material ID.

14.1.6 ifmDielectric material
 

ifmDielectric material with different attribute settings
 

Use the ifmDielectric material to render transparent or refractive materials such as glass and water. All attributes
and subsections create an effect which appears on the surface of the material.
 
Set material attributes in the Attribute editor window:
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ifmDielectric material attributes

14.1.6.1 Surface attributes
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Surface section of the ifmDielectric material
 
 

Thin walled
Turns the thin-walled attribute on or off. When selected, refracted light is treated as directly leaving the
material again. When unselected, objects need to be closed to have correct refractions.
 

Refraction Index
Light that goes through an object is bent. The value set for refraction describes this effect. The shader
uses Fresnel's formulas for dielectric interfaces to achieve this.
 

Reflection Color
Sets the reflected color. This attribute also influences the color of the reflected caustic effects.
 

Roughness
Sets the roughness of the material surface. A value of 0 describes a clear, transparent surface; a value of
1 sets a rough surface. Roughness does not appear inside the material; it is an effect that appears on the
surface.
 

Bump Map
Adds a bump map to the material.

14.1.6.2 Anisotropic attributes
 

Anisotropy section of the ifmDielectric material
 
 

Anisotropy
Turns anisotropy on or off. The geometry needs useful UV-coordinates to show the result. The values
scales the anisotropic effects along the V-direction of the UV texture coordinates.
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Rotation
Rotates the anisotropic effects in UV texture coordinates. A value of 1 describes a rotation of 360
degrees.

14.1.6.3  Dispersion attributes
 

Dispersion section of the ifmDielectric material
 
 

Dispersion
Turns dispersion on and off. When selected, this feature simulates the dispersion of color which, for
example, creates the rainbow effect when light travels through a glass prism.
 

Abbe Number
The Abbe Number is a measurement of how dispersive a material is. For example, optical glass (Glass
BK7) has a Abbe Number of 64. You can find various reference lists on the Internet.

14.1.6.4 Volume attributes
 

Volume section of the ifmDielectric material
 

All attributes create an effect which appears inside the material. When turning on "Thin Walled" some effects are
no longer available because these expect a closed object.
 
Scale

Adjusts the absorption and scattering cross section to the scale of the object. Lower values create
stronger absorption; higher values create less absorption.

 
Color
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Sets the color of the material and implicitly defines, together with the Scale attribute, the absorption cross
section of the material. Thus the amount determines how much of the light is transmitted and absorbed
by the volume. Use this attribute to create colored glass.

 
Scattering

Simulates the scattering inside the object the material is assigned to and implicitly defines, together with
the Scale attribute, the scattering cross section. Higher values need a higher value for the maximum path
length (Render Settings) to create correct results.

 
Scattering Direction

Specifies how light is scattered inside the object, where the default value of 0 defines isotropic scattering
– light is equally scattered in all directions. Use positive values for forward scattering; use negative values
for backward scattering.

14.1.6.5 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.1.7 ifmTransmittance material
 

ifmTransmittance material with different attribute settings
 

Use the ifmTransmittance material to render translucent materials such as paper and leaves. This material only
handles the transmission of light inside the material. You cannot get reflections with this material; for reflections,
you must combine ifmTransmittance and ifmOpaque.
 
Set material attributes in the Attribute editor window:
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ifmTranmittance material attributes
 
 

14.1.7.1  Diffuse attributes
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Diffuse section of the ifmTransmittance material
 
 

Color
The diffuse and main color of the material.

14.1.7.2 Specular attributes
 

Specular section of the ifmTransmittance material
 

Weight
The amount of specular weight. A value of 0 shows no specular reflection. A value of 1 shows only the
specular reflections.

 
Mode

The specular reflection of the material. Select one of the following attribute values:
 

Constant: The specular reflection of the material is angle independent.
 

Curve: The specular reflection of the material is defined by a custom curve, defined by:
•  At 0 Degree:

•  Specular reflection for angle of incidence normal to the surface.
•  At 90 Degree:

•  Specular reflection for angle of incidence at 90 degrees to surface normal.
•  Exponent:

•  Describes the transition between the values set at the attributes Specularity at 0 degrees
and Specularity at 90 degrees. It is the exponent for Schlick's approximation.

 
Fresnel: The specular reflection of the material is defined by the Fresnel term.

•  Refraction Index:
•  The refraction taken into account by the Fresnel term to define the specular reflection.
The attribute is defined using a float to describe the Fresnel Index.

 
Fresnel (Advanced): Same behaviour as Fresnel.
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•  Refraction Index:
•  The refraction taken into account by the Fresnel term to define the specular reflection.
The attribute is defined using a color. So for each channel R,G,B a different values for the
Fresnel Index are possible.

 
Color

The specular color of the material.
 
Roughness

The appearance of the specular reflection. A value of 0 describes a plain, smooth and highly reflective surface; a value of 1
describes a rough and dull surface.

14.1.7.3 Anisotropic attributes
 

Anisotropy ection of the material Attribute Editor
 
 

Anisotropy
Turns anisotropy on or off. The geometry needs useful UV-coordinates to show the result. The values
scales the anisotropic effects along the V-direction of the UV texture coordinates.
 

Rotation
Rotates the anisotropic effects in UV texture coordinates. A value of 1 describes a rotation of 360
degrees.

14.1.7.4  Volume attributes
 

Volume section of the ifmTransmittance material
 

All attributes create an effect which appears inside the material. When turning on "Thin Walled" some effects are
no longer available because these expect a closed object.
 
Scale

Adjusts the absorption and scattering cross section to the scale of the object. Lower values create
stronger absorption; higher values create less absorption.
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Color
Sets the color of the material and implicitly defines, together with the Scale attribute, the absorption cross
section of the material. Thus the amount determines how much of the light is transmitted and absorbed
by the volume. Use this attribute to create colored glass.

 
Scattering

Simulates the scattering inside the object the material is assigned to and implicitly defines, together with
the Scale attribute, the scattering cross section. Higher values need a higher value for the maximum path
length (Render Settings) to create correct results.

 
Scattering Direction

Specifies how light is scattered inside the object, where the default value of 0 defines isotropic scattering
– light is equally scattered in all directions. Use positive values for forward scattering; use negative values
for backward scattering.

14.1.7.5  Bump attributes
 

Bump section of the material Attribute Editor
 
 

Bump Map
Add a bump map to the material.

 

14.1.7.6 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.1.8 Measured material (AxF)
 
Iray for Maya 2.2 supports measured materials created by X-Rite. Iray can render materials stored in the AxF file
format, version 1.2 and higher. The supported AxF material representations are SVBRDF and CP2 (Carpaint)
with farfield look only (no Flakes). Since Iray for Maya 2.2 AxF SDK 1.5.1 has been integrated. This adds support
for GGX fitting targets (AxF SVBRDF profile version 3). These files are produced by devices such as the TAC7
scanner from X-Rite and regarded in the same way as MDL materials.
 
You must store AxF files in a directory that is accessible from MDL file paths. The recommended path is C:
\Users\username\Documents\mdl in a subdirectory called axf. AxF files stored in this path are displayed in
the browsing area of the ifmMDLMaterial as shown in the following figure:
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AxF files in the ifmMDLmaterial node
 
 
Since Iray for Maya 2.2 a new set of material features are supported:
 
•  The conversion of the car paint sub clear coat material has been improved:

a.  The directional color curve is now fully represented which yields correct rendering of color shifting
paints.
b.  Car paints with refractive clear coat are now supported.
c.  These improvements are realized via measured BRDFs in MDL.
d.  This behavior can optionally be disabled by a material parameter: if disabled, the material will not use
the measured BRDFand potentially render incorrectly though.
 

•  Car paint flakes are supported by a dedicated procedural:
a.  Flake statistics are derived from the measured flake BTF data in the AxF.
b.  Flakes are enabled by default if present in the AxF file. They can be disabled by a material parameter.
c.  The material exposes artistic controls to modify flake size, intensity, and reflection roughness.

14.2 Material emitters
 
In Iray for Maya, every geometry can act as a light emitter. Assign the available light emitting material to any
geometry.
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Create Render Node window to create Iray for Maya 2.2 material emitters

14.2.1 ifmIesEmitter material
 

 Visualizing an IES light profile
 

Use ifmIesEmitter material to visualize an IES light profile.
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IES stands for Illuminating Engineering Society. IES standard file format was created for the electronic transfer
of photometric data. It has be widely used by many lighting manufactures and is one of the industry standards
in photometric data distribution. An IES file is basically the measurement of distribution of light stored in ASCII
format. IES profile data files can be downloaded from many light manufactures websites.
 
Set material attributes in the Attribute Editor window:
 

 ifmIesEmitter material attributes

14.2.1.1 Common attributes
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Frontface

This attribute lets the geometry emit light in direction of the face normal
 
Backface

This attribute lets the geometry emit light opposite to direction of the face normal.
 
Note:

When the Frontface and Backface attributes are selected the geometry emits light in both
directions: along the face normal and opposite the face normal. If both attributes are
unselected, no light is emitted.

 
Light Profile

Load an IES light profile. IES profiles can be download from many manufactures web sites.
 
Note:

If this attribute is empty no light is emitted.
 
 
Intensity Mode
 

Calculates the intensity of the light emitter. Select one of the following attribute values:
 

•  intensity_power: Intensity is independent of the size of the geometry. Scaling the geometry
affects the light appearance but not the light intensity.
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•  intensity_radiant_exitance: Intensity is dependent on the size of the geometry. Scaling the
geometry affects both the light appearance and the light intensity.

 
Exponential Intensity

Multiplier to adjust the intensity of the light emitter.
 
Color

Defines the emitted light color

14.2.1.2 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.2.2 ifmOmniEmitter material
 

Geometry acting as a light emitter
 

Use ifmOmniEmitter material to emit light evenly in a hemisphere. Light is emitted above the face normal of the
assigned geometry.
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Set material attributes in the Attribute Editor window:
 

ifmOmniEmitter material attributes
 
 

14.2.2.1  Common attributes
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ifmOmniEmitter material attributes
Frontface

This attribute lets the geometry emit light in direction of the face normal
 
Backface

This attribute lets the geometry emit light opposite to direction of the face normal.
 
Note:

When the Frontface and Backface attributes are selected the geometry emits light in both
directions: along the face normal and opposite the face normal. If both attributes are
unselected, no light is emitted.
 

Intensity Mode
 

Calculates the intensity of the light emitter. Select one of the following attribute values:
 

•  intensity_power: Intensity is independent of the size of the geometry. Scaling the geometry
affects the light appearance but not the light intensity.
 
•  intensity_radiant_exitance: Intensity is dependent on the size of the geometry. Scaling the
geometry affects both the light appearance and the light intensity.

 
Exponential Intensity

Multiplier to adjust the intensity of the light emitter.
 
Color

Defines the emitted light color
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14.2.2.2 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.2.3 ifmSpotEmitter material
 

ifmSpotEmitter light emitting material
 

Set material attibutes in the Attribute Editor window:
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ifmSpotEmitter material attributes

14.2.3.1 Common attributes
 

Common section of the ifmSpotEmitter material
 

Frontface
This attribute lets the geometry emit light in direction of the face normal
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Backface
This attribute lets the geometry emit light opposite to direction of the face normal.

 
Note:

When the Frontface and Backface attributes are selected the geometry emits light in both
directions: along the face normal and opposite the face normal. If both attributes are
unselected, no light is emitted.
 

Intensity Mode
 

Calculates the intensity of the light emitter. Select one of the following attribute values:
 

•  intensity_power: Intensity is independent of the size of the geometry. Scaling the geometry
affects the light appearance but not the light intensity.
 
•  intensity_radiant_exitance: Intensity is dependent on the size of the geometry. Scaling the
geometry affects both the light appearance and the light intensity.

 
Exponential Intensity

Multiplier to adjust the intensity of the light emitter.
 
Color

Defines the emitted light color

14.2.3.2 Spread attributes
 

Spread section of the ifmSpotEmitter material
 
 

Cone Angle
Spread or angle of the cone to which the cosine distribution is restricted. The hemispherical domain for
the distribution is rescaled to this cone.

 
Penumbra

The decay rate of light inside the defined Spread. The value describes the exponent for cosine of the
angle between the axis and the sample point.

14.2.3.3 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID
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See the section The material ID.

14.3 Material layers
 
Material Layers are designed to add specific material characteristics to a material. This characteristic is layered
on top of another material.
 

Create Render Node window to create Iray for Maya 2.2 material layers

14.3.1 ifmClearCoat material layer
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ifmClearCoat material attributes
 

Use ifmClearCoat material to define a reflection layer, which can be added to a given material.

14.3.1.1  Input material
 

Input material
 
 

Base Material
Slot for the material the clear coat is added to.

14.3.1.2 Clear coat attributes
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Clear coat attributes
 
 

Refraction Index
Defines the refraction taken into account by the Fresnel term to define the clear coat reflection.

 
Weight

Controls the opacity and visibility of the clear coat reflection
 
Roughness

Defines the glossiness of the clear coat reflection. For a "perfect" reflection, specify 0. To blur the
reflection, use higher values.

 
Bump Map

Adds a bump map to the clear coat layer.
 

 

14.3.1.3 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.3.2 ifmThinFilm material layer
 
ifmThinFilm simulates color hue changes caused by very thin coatings of refractive material. When the thickness
of the coating is close to the range of wavelengths of visible light, interference causes shifts in the hue of
reflected light. The effect is observable on certain types of anodisation (e.g. with titanium oxides), heated metals,
gasoline spills, soap bubbles, and so on.
 
Set material attributes in the Attribute Editor window:
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14.3.2.1 Input material attributes
 

Input material attributes
 
 

Base Material
Slot for the material to which the thin film effect should be layered.

14.3.2.2 Thin film attributes
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Thin film attributes
 
 

Thickness
Thickness of the thin film in nanometers.

 
Refraction Index

Light that goes through an object is bent. The value set for refraction describes this effect. The shader
uses Fresnel's formulas for dielectric interfaces to achieve this.

14.3.2.3 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.4 Material tools
 
Material Tools are designed to combine given materials in many different ways. They help to design your own
material network without the need of programming skills. It is possible to chain different material tools together to
achieve specific effects.
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Create Render Node window to create Iray for Maya 2.2 material tools

14.4.1 ifmAddEmission material tool
 

ifmAddEmission
 

ifmAddEmission adds a light emitting material to a non-emitting material.
 
Example: Model a glow wire which is made of tungsten. Set up the tungsten material and use ifmAddEmission to
add the light emitting ability. Now you can easily animate the transition when the light is turned on.
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ifmAddEmission material attributes
 

14.4.1.1 Input materials attributes
 

Input Materials section
 
 

Surface Material
Slot for the non-emissive material
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Emission Material
Slot for the light emissive material.

14.4.1.2 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.4.2 ifmBlender material tool
 

ifmBlender material
 

ifmBlender is needed when you want to combine different material setups and blend them.
 
Example: Use this material tool to combine an opaque and a transparent material on one single geometry.
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ifmBlender material attributes

14.4.2.1 Input materials attributes
 

Input Materials section
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Base

Slot for the underlying base material.
 
Layer

Slot for the material layered on top of the base material.
 
Note:

ifmBlender only blends the surface information of the connected materials. When mixing
materials containing volumes it is important which material is connected to Base and
which to Layer. Only the volume information of the Base material is taken into account.

14.4.2.2 Blending attributes
 

Blending section
 

Weight
Sets the overall opacity of the material layer. A value of 0 shows the base material, a value of 1 the
layered material.

 
Mode

Defines the way how the blending is calculated
 

Constant
This mode determines the opacity of the layer directly, without any dependency on the incident
angle.
 

Curve: The weight is multiplied by a Fresnel-like customizable curve. This method is intended to provide
artistic control.

•  At 0 Degrees: Sets the weight for angle of incidence normal to the surface.
 
•  At 90 Degrees: Sets the weight for angle of incidence at 90 degrees to surface normal.
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•  Exponent: Describes the transition between the values set at the attributes At 0 Degree and At
90 degree. It is the exponent for Schlick's approximation.
 

 Fresnel
The weight is multiplied by a Fresnel curve, calculated using the provided index of refraction.
This is typically the physically-correct approach to rendering varnishes, clear coats, and Fresnel
reflections.
•  Refraction Index:

•  The refraction taken into account by the Fresnel term to define the specular reflection.
The attribute is defined using a float to describe the Fresnel Index.

 
Fresnel (Advanced): Same behaviour as Fresnel.

•  Refraction Index:
•  The refraction taken into account by the Fresnel term to define the specular reflection.
The attribute is defined using a color. So for each channel R,G,B a different values for the
Fresnel Index are possible.

 
Refraction Index

Defines the refraction taken into account by the Fresnel term to define the specular reflection.

14.4.2.3 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID

See the section The material ID.

14.4.3 ifmDoubleSided material tool
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ifmDoubleSided material
 

ifmDoubledSided enables the user to assign two different material on one single surface. The materials appears
on the side that is defined by the surface normal and the opposite side of the face.
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ifmDoubleSided material attributes
 

14.4.3.1 Input materials attributes
 

Input Materials section in the material Attribute Editor
 
 

Frontface Material
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Connect the material to the geometry side that is defined by the direction of the surface normal.
 
Backface Material

Connect the material to the opposite side of the direction of the surface normal.

14.4.3.2 Switches attributes
 

Switches section in the material Attribute Editor
 

Geometry Modification
If both input materials contain an ifmGeometryModifer node only one of them can be used. This attribute
defines how this behaviour will be handled.

 
Geometry Modification: None

If the input materials contains ifmGeometryModifer nodes, these will be ignored.
 

Geometry Modification: Frontface
If the input materials contains ifmGeometryModifer nodes, the one assigned to Frontface will be
taken into account.

 
Geometry Modification: Backface

If the input materials contains ifmGeometryModifer nodes, the one assigned to Backface will be
taken into account.

14.4.3.3 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID
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See the section The material ID.

14.4.4 ifmGeometryModifier
 

ifmGeometryModifier material
 

This node has a special role and acts different than the other material tools. ifmGeometryModifier affects the way
the geometry is interpreted by the material. It is needed to create displacement effects, transparent areas without
refraction or to add bump effects on top of all other materials.
 
You can chain different ifmGeometry nodes together, but only the last one which is assigned to the geometry will
be taken into account. This is important to know when you combine materials from an external MDL library with
this tool. All attributes like displacement, cutout or round corner from a loaded library material will be ignored as
soon as the materials are connected to an ifmGeometryModifier.
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ifmGeometryModifier material attributes

14.4.4.1 Input material attributes
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Input Materials section in the material Attribute Editor
 
 

Surface
Slot for the incoming material or material network.

14.4.4.2 Displacement attributes
 

Displacement section in the material Attribute Editor
 

 
Displacement

Add a texture map as displacement map. The displacement is calculated at render time.
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14.4.4.3 Cutout opacity attributes
 

Displacement section in the material Attribute Editor
 
 

Cutout Opacity
The cutout opacity map is used to make the surface transparent without refraction. This is useful to create
details which may be too expensive to model geometrically, for example the outline of tree leaves.

14.4.4.4 Normal attributes
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Normal section in the material Attribute Editor
 

Rounded Corner
Rounded corners are a procedural bump mapping effect which alters the normal near geometric edges
to create a rounded corners look. Optionally, the effect can be applied to corners that intersect different
materials.

 
Radius

Sets the radius of the round corner effect in world space units.
 
Roundness

Determines how round the edge will look. The valid range is between 0.0 and 1.0. A value of 0.0
chamfers the edge and a value of 1.0 gives a rounded edge
 

Blend With other Materials
Applies the round corner effect to intersection areas of different materials.

 
Bump

Adds a bump map which effects the overall material.

14.4.4.5 Miscellaneous attributes
 

Misc ection of the material Attribute Editor
 
Material ID



 

232

See the section The material ID.

14.4.5 ifmSwitcher
 

ifmSwitcher material
 

The ifmSwitcher is a container to collect inputs of 8 different materials. You can assign the ifmSwitcher to a
geometry and then select which of the connected materials will be rendered.
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Different materials connected to the ifmSwitcher
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ifmSwitcher attributes
 

Selector
Use this attribute to select which one of the material inputs will be rendered.

 
Material 1-8

Use this attribute to connect a material to the ifmSwitcher.

14.5 The material ID
 

Many materials contain an attribute used to identify the material to Iray, called the material ID. The material ID
attribute contains the following parameters.
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Material ID in the misc section of the Attribute Editor
 
Material ID

Set the following attributes to modify the material ID
 
Automatic

Applies a random integer number as an material ID for the objects to which the material is
assigned. The number is generated using the material name.

 
Set

This value is used to keep the material ID color for the objects to which the material is assigned
consistent during an animation. There are two ways to set the material ID color of the selected
material:

 
1.  Apply a defined integer number as an material ID.

 
2.  Click on the color field to open a color chooser to define the material ID color. You can
also define a custom color for the alpha channel of the material ID canvas.
 

Type a number to define a color or click on the color field to open the RGBA Color Chooser.
 
 



 

236

Use the RGBA Color Chooser to select a color for the RGB channels and the Alpha channel of the material ID canvas.
 

Note:
Due to a bug in Maya on Windows OS the color field beside Material ID ➤ Set is getting
dark grey after setting the color in the RGBA Color Chooser. You need to switch the
Material ID attribute once and then go back to Material ID ➤ Set to see the correct color in
the color field.

15 Textures
 
The textures described in chapter 14.1 are Iray specific 3D-textures and can only be used by Iray for Maya 2.2.
The texutres listed in chapter 14.2 are delivered with Maya and can be used by Iray.
 

Create Render Node window to create Iray for Maya 2.2 3D textures
 

15.1 Procedural textures
 
The textures described in chapter 14.1 are Iray specific 3D-textures and can only be used by Iray for Maya 2.2.
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15.1.1 ifmChecker texture
 

ifmChecker texture
 

ifmChecker is a three-dimensional procedural texture to create a simple checker board texture.
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Attributes of the ifmChecker texture
 
 

15.1.1.1 Checker attributes
 

Checker section of the ifmChecker Attribute Editor
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Coordinate System
Defines in which coordinate system the ifmFlowNoise will be displayed.

 
•  Object:

•  Specifies to position the texture in object space. This effects mainly the scaling of the texture.
When object space is valid the texture size sticks to the scaling factor of the object.

•  World:
•  Specifies to position the texture in world space. When world space is valid the texture size is
independent of the scaling factor of the object.

•  UV:
•  Specifies to position the texture in UV space.
 

Blur
Softens the border between tiles.
 

Division Ratio
Ratio of division. Values other than 0.5 produce non-square tiles.

15.1.1.2 Color attributes
 

Color section of the ifmChecker Attribute Editor
 
 

1st Color
The checker function blends between this color and 2nd Color.
 

2nd Color
The checker blends between this color and 1st Color.

15.1.1.3 Bump attributes
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Bump section of the ifmChecker Attribute Editor
 
 

Depth
Defines the bump depth if the texture is connected to the bump attribute of an Iray for Maya 2.2 material.

15.1.2 ifmFlakeNoise texture
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ifmFlakeNoise texture
 

ifmFlakeNoise is a three-dimensional procedural texture to create texture effects for flakes in metallic car paint.
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Attributes of the ifmFlakeNoise texture
 

15.1.2.1 Flake noise attributes
 

Flake Noise section of the ifmChecker Attribute Editor
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Coordinate System

Defines in which coordinate system the ifmFlakeNoise will be displayed.
 

•  Object:
•  Specifies to position the texture in object space. This effects mainly the scaling of the texture.
When object space is valid the texture size sticks to the scaling factor of the object.

•  World:
•  Specifies to position the texture in world space. When world space is valid the texture size is
independent of the scaling factor of the object.

•  UV:
•  Specifies to position the texture in UV space.

 
Size

Size of the biggest feature of the pattern
 

Flake Noise section of the ifmChecker Attribute Editor
 

Noise Type
Choose between Worley or Classic to define the look of the flake shape.

 
Maximum Size

Controls the shape of flakes when Worley is selected.
 
Metric

Defines the shape of the flake patterns features.
 

•  euclidean:
•  Defines a more regular shape of the single flake shape.

•  manhattan:
•  Defines a more irregular shape of the single flake shape.

•  chebyshev:
•  Defines a specific shape of the single flake shape using Chebyshev's sum inequality.



 

244

 
Note:

This attribute is only valid when Noise Type is set to 1 (worley).
 

 

15.1.2.2 Color attributes
 

Color section of the ifmFlakeNoise Attribute Editor
 
 

 
Intensity

    Specifies the intensity or reflectivity of the flakes.
 
Density

    Controls the contrast between the brightest and darkest flakes.

15.1.2.3 Bump attributes
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Bump section of the ifmFlakeNoise
 
 

Depth
Defines an imaginery depth. Lower values let flakes appear more equally bright. Higher values let the
flakes appear differently bright, as if they some are deeper in the imaginery volume.

15.1.3 ifmFlowNoise texture
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ifmFlowNoise texture
 

ifmFlowNoise is a three-dimensional procedural texture based on Perlin noise function. It adds some attribute
specific to animation.
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Attributes of the ifmFlowNoise texture

15.1.3.1 Flow noise attributes
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Perlin Noise section of the ifmFowNoise Attribute Editor
 

Coordinate System
Defines in which coordinate system the ifmFlowNoise will be displayed.

 
•  Object:

•  Specifies to position the texture in object space. This effects mainly the scaling of the texture.
When object space is valid the texture size sticks to the scaling factor of the object.

•  World:
•  Specifies to position the texture in world space. When world space is valid the texture size is
independent of the scaling factor of the object.

•  UV:
•  Specifies to position the texture in UV space.
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Perlin Noise section of the ifmFowNoise Attribute Editor
 

Phase
Controls the fourth dimension of the function. This can be time in animation.
 

Absolute
Creates a more billowing and turbulent appearance of the noise. The pattern is more dotted.
 

Level Gain
If multiple levels are used, this attribute specifies a weighting factor for subsequent levels.
 

Level Scale
If multiple levels are used, this attribute specifies a global scaling factor for subsequent levels.
 

Progressive Scale
If multiple levels are used, this attribute specifies an additional scaling factor which can be used for
animation.
 

Progressive Motion
If multiple levels are used, this attribute specifies an offset for subsequent levels which can be used for
animation.

15.1.3.2 Color attributes
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Color section of the ifmFlowNoise Attribute Editor
 
 

1st Color
The perlin noise function blends between this color and 2nd Color.
 

2nd Color
The perlin noise function blends between this color and 1st Color.

15.1.3.3 Bump attributes
 

Bump section of the ifmFlowNosie Attribute Editor
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Depth

Defines the bump depth if the texture is connected to the bump attribute of an Iray for Maya 2.2 material.

15.1.4 ifmPerlinNoise texture
 

ifmPerlinNoise texture
 
ifmPerlinNoise is a three-dimensional procedural texture to create natural texture effects like clouds, smoke, fire,
etc.
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Attributes of the ifmPerlinNoise texture

15.1.4.1 Perlin Noise attributes
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Perlin Noise section of the ifmPerlinNoise Attribute Editor
 

Coordinate System
Defines in which coordinate system the ifmPerlinNoise will be displayed.

 
•  Object:

•  Specifies to position the texture in object space. This effects mainly the scaling of the texture.
When object space is valid the texture size sticks to the scaling factor of the object.

•  World:
•  Specifies to position the texture in world space. When world space is valid the texture size is
independent of the scaling factor of the object.

•  UV:
•  Specifies to position the texture in UV space.
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Perlin Noise section of the ifmPerlinNoise Attribute Editor
 

Size
Size of the biggest feature of the pattern
 

Apply Marble
Interpolation to get a marble like appearance.
 

Apply Dent
Increases the contrast of the texture by raising the output of the function by the power of 3.

 
Phase

Controls the fourth dimension of the function. This can be time in animation.
 

Levels
Controls the frequency of noise.

 
Absolute
Creates a more billowing and turbulent appearance of the noise. The pattern is more dotted.
 
Rigded

Creates a more electrical appearance. The pattern is more connected.
 
Distortion

Weight of additional noise turbulence.
 
Threshold High

Noise values greater then this attribute are mapped to color1.
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Threshold Low

Noise values greater then this attribute are mapped to color2.
 
Bands

Creates a "tree ring" like banding effect.

15.1.4.2 Color attributes
 

Color section of the ifmPerlinNoise Attribute Editor
 
 

1st Color
The checker function blends between this color and 2nd Color.
 

2nd Color
The checker blends between this color and 1st Color.

15.1.4.3 Bump attributes
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Bump section of the ifmPerlinNoise
 
 

Depth
Defines the bump depth if the texture is connected to the bump attribute of an Iray for Maya 2.2 material.

15.1.5 ifmTile texture
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ifmTile texture
 

ifmTile is a three-dimensional procedural texture to create textures for tiles, bricks etc.
 
 



 

258

Attributes of the ifmTile texture

15.1.5.1 Tile attributes
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Tile section of the ifmTile Attribute Editor
 

Coordinate System
Defines in which coordinate system the ifmTile will be displayed.

 
•  Object:

•  Specifies to position the texture in object space. This effects mainly the scaling of the texture.
When object space is valid the texture size sticks to the scaling factor of the object.

•  World:
•  Specifies to position the texture in world space. When world space is valid the texture size is
independent of the scaling factor of the object.

•  UV:
•  Specifies to position the texture in UV space.
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Tile section of the ifmTile Attribute Editor
 

Rows
Number of tile rows in the select texturing domain.

 
Columns

Number of tile columns in the selected texturing domain.
 
Grout Width

Absolute width of vertical grout lines.
 
Grout Height

Absolute height of horizontal gap between the tiles.
 
Grout Roughness

Amount of noise added to the gap between the tiles.
 
Missing Amount

Number of tiles that will end up as grout, rather than as a tile. The attribute range is from 0 to 1. In some
situation this attribute creates a result that shows only the grout color. Modify the attribute seed to get the
expected result.
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Seed
Seeding number for random number generator controlling tile randomization effects.

 
Brightness Variation

Randomization factor to the brightness of the tile color.
 
Special Row

This attribute defines the number of rows at which the width of tiles is modified. Setting this attribute to 0
is not recommended.

 
Special Row Width

Change of width for tiles identified through the attribute Special Row
 
Special Column

This attribute defines the number of columns at which the width of tiles is modified. Setting this attribute to
0 is not recommended.

 
Special Column Width

Change of width for tiles identified through the attribute Special Row.
 
Odd Row Offset

Controls the bonding pattern. 0 will result in a "stack bond", 0.5 in a "running bond".
 
Random Row Offset

Randomization factor for the attribute Odd Row Offset.
 
Note:

It might be necessary to change and to thoroughly fine-tune the Seed value to achieve
noticeable results when using random-based attributes (Missing Amount, Brightness
Variation, Random Row Offset).

15.1.5.2 Color attributes
 

Color section of the ifmTile Attribute Editor
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Tile Color
Defines the tile color.

 
Grout Color

Defines the color of the gap between the tiles.

15.1.5.3 Bump attributes
 

Bump section of the ifmTile
 
 

Depth
Defines the bump depth if the texture is connected to the bump attribute of an Iray for Maya 2.2 material.

15.1.6 ifmWorleyNoise texture
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ifmWorleyNoise texture
 

ifmWorleyNoise is a three-dimensional procedural texture to create texture effects like cell structures, gravel
patterns or water.
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Attributes of the ifmPerlinNoise texture

15.1.6.1 Worley Noise attributes
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Worley Noise section of the ifmWorleyNoise Attribute Editor
 

Coordinate System
Defines in which coordinate system the ifmWorleyNoise will be displayed.

 
•  Object:

•  Specifies to position the texture in object space. This effects mainly the scaling of the texture.
When object space is valid the texture size sticks to the scaling factor of the object.

•  World:
•  Specifies to position the texture in world space. When world space is valid the texture size is
independent of the scaling factor of the object.

•  UV:
•  Specifies to position the texture in UV space.

Size
Size of the biggest feature of the pattern

 
Mode

Controls the interpolation of the output pattern of the noise function.
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Worley Noise section of the ifmWorleyNoise Attribute Editor
 
 

Metric
Defines the shape of the flake patterns features.

 
•  euclidean:

•  Defines a more regular shape of the single flake shape.
•  manhattan:

•  Defines a more irregular shape of the single flake shape.
•  chebyshev:

•  Defines a specific shape of the single flake shape using Chebyshev's sum inequality.
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Worley Noise section of the ifmWorleyNoise Attribute Editor
 
Apply Marble

Interpolation to get a marble like appearance.
 
Apply Dent

Increases the contrast of the texture by raising the output of the function by the power of 3.
 
Distortion

Weight of additional noise turbulence.
 
Threshold High

Noise values greater then this attribute are mapped to color1.
 
Threshold Low

Noise values greater then this attribute are mapped to color2.
 
Bands

Creates a "tree ring" like banding effect.
 
Step Threshold

Used only in mode 3 and defines the gap size between the cell shapes.

15.1.6.2 Color attributes
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Color section of the ifmWorleyNoise Attribute Editor
 
 

1st Color
The worley noise function blends between this color and 2nd Color.
 

2nd Color
The worley noise blends between this color and 1st Color.

15.1.6.3 Bump attributes
 

Bump section of the ifmWorleyNoise
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Depth

Defines the bump depth if the texture is connected to the bump attribute of an Iray for Maya 2.2 material.

15.2 Directly supported Maya textures and utilities
 
Iray for Maya 2.2 supports some Maya textures and utility nodes directly. This means these nodes can
be plugged directly intoIray for Maya 2.2 materials. All other 2D Textures nodes and Utilities need the
ifmMayatTexture2d node.

15.2.1 Directly supported Maya textures
 
These Maya textures will be supported directly by Iray for Maya 2.2:
 
2D Texture:

•  Bulge
•  Checker
•  Cloth
•  File
•  Fractal
•  Grid
•  Mountain
•  Ramp

 
3D Textures:

•  Brownian
•  Marble
•  Snow
•  Solid Fractal

 

15.2.2 Directly supported Maya utilities
 
These Maya utilities will be supported directly by Iray for Maya 2.2:
 
Utilities:

•  AddDoubleLinear
•  BlendColors
•  Bumpd2d
•  Bump3d
•  Condition
•  Contrast
•  DistanceBetween
•  GammaCorrect
•  HSVtoRGB
•  LayeredTexture
•  MultiplyDivide
•  MultiDoubleLinear
•  Place2dTexture
•  Projection

Limitation:
•  Bump Mapping is not supported

Camera Projection Attributes:
•  Fit Type not supported
•  Fit Fill not supported

 
•  PlusMinusAverage
•  RemapColor
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•  RemapHSV
•  RemapValue
•  Reverse
•  RGBtoHSV
•  SetRange
•  VectorProduct
•  Color Composite
•  Color Condition
•  Color Constant
•  Color Correct
•  Color Logic
•  Color Mask
•  Color Math
•  singleShadingSwitch
•  doubleShadingSwitch
•  tripleShadingSwitch
•  uvChooser
 

16 Utilities
 
In some areas Iray uses a different approach than Maya regarding material and textures. This makes it difficult
to make all textures and utilities from within Maya available in Iray for Maya 2.2. Currently Iray for Maya 2.2
supports many textures and utilities directly. You can find a list of supported nodes in the section “Directly
supported Maya textures and utilities.” All other 2d-textures must be piped through the ifmMayaTexture2d node to
be used in Iray for Maya 2.2.
 

Create Render Node window to create Iray for Maya 2.2 utilities

16.1 ifmMayaTexture2d
 
Use the ifmMayaTexture2d node as a translator to make any procedural 2D texture networks available for Iray for
Maya 2.2 materials. It bakes the incoming result to a file texture and applies it to the assigned Iray for Maya 2.2
material. This node is also required when some Maya Utility nodes are used in conjunction with file textures.
 
The different approaches of Maya and Iray result in some dissimilarities when dealing with the positioning
in UV space. Because of this reason the ifmMayaTexture2d has its own section for UV positioning. This has
performance reasons as well. In some cases, for example, when using many repetitions, it is recommended to
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shift UV placement settings from the 2dTexturePlacement to the ifmMayaTexture2d node. This makes the use of
this node much more efficient because a lower precision can be used.
 

The Attribute Editor of the ifmMayaTexture2d node

16.1.1  Input attributes
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Input section of the ifmMayaTexture2D Attribute Editor
 
 

Color
Connects the incoming RGB values from the texture with this attribute.

 
Alpha

Connects the incoming float value from the texture with this attribute.
 
Precision

Sets the size of the ifmMayaTexture result for rendering in Iray for Maya. High values give better results
but will slow down interactivity. Small values increase interactivity.

16.1.2 Texture placement attributes
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Texture section of the ifmMayaTexture2D Attribute Editor
 

Crop U
Defines the value range of the texture to be shown in the U texture space of the object. A value of 0 to .5
will show just on half of the texture in the UV space from 0 to 1.

 
Crop V

Defines the value range of the texture to be shown in the V texture of the object. A value of 0 to .5 will
show just on half of the texture in the UV space from 0 to 1.

Clip
Cuts off the parts of the texture space that are not covered by Crop U and Crop V.
 

 

Texture section of the ifmMayaTexture2D Attribute Editor
 

Wrap U
Defines the way the texture will be placed in U space.

 
Clamp:

Repeats the color value of the textures border pixel along U texture direction.
Repeat:

    Repeats the texture in U texture direction.
Mirrored Repeat:

    Repeats the texture in U texture direction and mirrors it.
 
Wrap V

Defines the way the texture will be placed in V space.
 
Clamp:

Repeats the color value of the textures border pixel along V texture direction.
Repeat:

    Repeats the texture in V texture direction.
Mirrored Repeat:

    Repeats the texture in V texture direction and mirrors it.
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16.1.3 UV transformation attributes
 

UV Transformation section of the ifmMayaTexture2D Attribute Editor
 
 

Scale
Modifies the size of the texture in UV space.

 
Offset

Modifies the position of the texture in UV space.
 
Rotate

Rotates the texture in UV space.

16.1.4 Color balance attributes
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Color balance section of the ifmMayaTexture2D Attribute Editor
 
 

Gamma
Applies a gamma value to the texture. Changing this value is normally not necessary for pure procedural
texture networks.

 
Note:

In case of upstream file texture nodes, for example, color remapping, this setting has to
be used to "de-gamma" the file texture.

 
Color Offset

Adds the defined RGB value to the texture.
 
Color Gain

Multiplies the defined RGB value to the texture.

16.1.5 Bump attributes
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Bump section of the ifmMataTexture2D  Attribute Editor
 
 

Depth
Defines the bump depth if the texture is connected to the bump attribute of an Iray for Maya 2.2 material.

16.2 ifmNormalMapping
 
Iray for Maya 2.2 handles normal maps different than Maya. In Maya the normal map can be used by switching
the attribute Use As: in the bump2d node to Tangent Space Normals or Object Space Normals. Unfortunately this
mechanism does not work for Iray for Maya 2.2. To take advantage of normal maps with Iray for Maya 2.2 the
ifmNormalMapping node is introduced.
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The Attribute Editor of the ifmNormalMapping node

16.2.1 General attributes
 

General section of the ifmNormalMapping Attribute Editor
 

Normal Map
Connects the RGB values from the normal map texture with the ifmNormalMapping node.

 
Type
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Defines how to read the normal map color values
 
Color:

Use this attribute if your using a normal map with just postive RGB values ( RGB 0 - 1 or 0 -255).
Vector:

Use this attribute if your using a normal map with negative and positive values ( This may apply
when using exr textures as normal maps )
 

 

General section of the ifmNormalMapping Attribute Editor
 

Tangent/Bitangent
There is not any sort of standardization for the creation of normal maps. But many normal maps are
defined as tangent space normal maps with RGB matching to XYZ. As a rule of thumb you can say
when looking on such a normal map in a standard image viewer usually blue is flat, normals pointing
upwards are cyan and normals pointing downwards are magenta. This is applies to the default setting in
the attribute Tangent/Bitangent which is Red Green / XY. You can change this mapping using the different
settings you find in the pulldown menu.

16.2.2 Advanced attributes
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Advanced section of the ifmNormalMapping Attribute Editor
 
 

Directional Bump
Use this attribute to set the bump depth independent for tangent and bitangent. If this attribute is on the
attribute Bump Depth in the General section of the ifmNormalMapping node has no effect.

 
Note:

To connect the ifmNormalMapper you can simply drag and drop the node to the
bump map attribute of any Iray for Maya 2.2 material. The basic connection is
ifmNormalMapper.outNormal to, for example, ifmOpaque.bump. Because most normal
maps are written in sRGB color space Iray for Maya 2.2 connects automatically a
gammaCorrect node between the file node and ifmNormalMapping. The default setting for
the Gamma attribute for the gammaCorrect node is 2.2, 2.2, 2.2.
 

The default material network for the ifmNormalMapping node

16.3 ifmSolarConfiguration
 
Use this node to adjust the ifmHosekSkylight node based on real world coordinates.
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The Attribute Editor of the ifmSolarConfiguration node
 

To connect ifmSolarConfiguration, click on the "add solar configuration" node of the ifmHosekSunlightShape
node.
 
You can also drag and drop the ifmSolarConfiguration node on the ifmHosekSkylightShape node in Hypershade
and select Default. As an alternate you can connect ifmSolarConfiguration.outElevation to
ifmHosekSkylightShape.solarElevation and ifmSolarConfiguration.outAzimuth to
ifmHosekSkylightShape.solarAzimuth using the Node Editor or Connection Editor.
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Shading network of the connected ifmSolarConfiguration node

16.3.1 Location attributes
 

Location section of the ifmSolarConfiguration Attribute Editor
 
 

Latitude
Let you specify the geographic coordinate of a given place using the north-south position of a point on
earth's surface.

 
North/South

Sets the north or south direction for the world coordinate system. By default it is set to north, which
means that the +X direction points to the north, assuming Maya is configured to Y-Up.

 
Longitude
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Let you specify the geographic coordinate of a given place using the east-west position of a point on
earth's surface.

 
East/West:

Sets the east or west direction for the world coordinate system. By default it is set to east, which means
that the +Z direction points to the east, assuming Maya is configured to Y-Up.

16.3.2 Date and time attributes
 

Date/Time section of the ifmSolarConfiguration Attribute Editor
 
 

Date
Let you specify the date to set the skylight simulation. The format is day, month, year.

 
Time

Let you specify the time to set the skylight simulation. The format is hour, minute, second.
 
Time Zone

Let you specify the time zone for the chosen point. A value of 0 is equivalent to UTC 0.

16.3.3 Time offset attributes
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Time Offset section of the ifmSolarConfiguration Attribute Editor
 

The Time Offset section is designed to make daylight animations easier.
 
Days

Specifies the time offset in days.
 
Hours

Specifies the time offset in hours.
 
Minutes

Specifies the time offset in minutes.
 
Seconds

Specifies the time offset in seconds.
 
Multiplier

Specifies the factor to be multiplied to the other attributes in the Time Offset section. The result will be
added to the time set in the Date / Time section. This attribute is meant to be keyframed.

 
Example:

The date in the Date / Time section is set to 01.04.2014 (1st of April 2014), 12:00:00, Time
Zone 2.

 
If in the Time Offset section the values are set to Days = 0, Hours = 0, Minutes = 5,
Seconds = 0 and Multiplier = 1. The sun is set to the positon 01.04.2014 (1st of April 2014),
12:05:00, Time Zone 2.

 
If the Multiplier is set to 2, the time will be 12:10:00. A value of 3 results in 12:15:00.

16.4 ifmState
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The Attribute Editor of the ifmState node
 
The ifmState node allows access to some internal renderer state values, like the current position to be shaded.
Furthermore it contains some useful derivatives of these values. Just to mention one example, Normals Angle
gives the angle between the geometry normal and the smoothed shading normal, which can be used as analysis
tool to figure out the greatest weaknesses of a given mesh or for faking e.g. weathering.
Note that these values are not available or not as expected in preprocessing steps like displacement calculations.
 
Input Attributes
 
Vertex Color Id

The index of the uvw texture space used for the current vertex color set. If the object has e.g. four uv
sets, the vertex color set is stored in uvw texture space with index four.
 

Vector
The vector used to compute Normal Vector Dot Product and/or Normal Vector Angle.
 

Points
An array of points to compute Minimum Distance, Minimum Distance Vector, and/or Minimum Distance
Absolute Vector.

 
Output Attributes
 
Position

The intersection point on the surface or the sample point in the volume.
 
Normal

The shading surface normal as a unit-length vector.
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Geometry Normal
The true geometric surface normal for the current geometry as a unit-length vector.

 
Vertex Color

The vertex color of the current vertex color set is written as last uvw texture space. If the object has e.g.
four uv sets, the vertex color set is stored in uvw texture space with index four, which has to be set as
Vertex Color Id.

 
Label

Returns the label as integer number.
 
Animation Time

The time of the current sample in seconds, including the time within a shutter interval.
 
Normals Dot Product

The dot product of Normal and Geometry Normal.
 
Normals Angle

The angle between Normal and Geometry Normal in radians.
 
Normal Vector Dot Product

The dot product of Normal and Vector.
 
Normal Vector Angle

The angle between Normal and Vector in radians.
 
Minimum Distance

The minimum distance between Position and the closest point to Position in Points. If Points does not
contain any point, Minimum Distance is zero.

 
Minimum Distance Vector

The vector from the closest point to Position in Points to Position. The vector components may be
negative. If Points does not contain any point, Minimum Distance Vector is the zero vector.

 
Minimum Distance Absolute Vector

The absolute vector from the closest point to Position in Points to Position. The vector components are
never negative. If Points does not contain any point, Minimum Distance Absolute Vector is the zero
vector.

 

17 Light path expressions
 
A light path expression (LPE) expresses a series of light and object interaction events using symbols to describe
the reflective and tramissive properties of surfaces. NVIDIA provides other documents describing the structure
of LPEs — their grammar — in detail. The following sections show the LPEs defined as part of Iray for Maya 2.2
that can serve as an introduction for artists to this powerful and flexible capability of Iray.
16.1Examples of light path expressions
 
Light path expressions are a complex and powerful way to control the content of various canvases. Some artists
may find it difficult to develop an intuitive understanding of LPEs — but it is definitely worth a try. This section
gives you some practical hints for many typically useful tasks.
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The example Maya scene LPE_example_scene.mb contains a simple setup with a few objects, a Sun and Sky
environment light and a light emitting polygon plane. The scene is available for download at the [0x1] website.
 
In the following chapter this is used to explain LPEs and to split the image in a set of framebuffer that can be
used for composing.

17.1 LPE User Interface
 
The user interface for the LPE are in the Render Settings window in the Output tab. Each canvas contains a LPE
and an Alpha LPE attribute. The LPE attributes writes the output in the Red, Green, Blue channels of the image,
the Alpha LPE in the Alpha channel.
When the attribute appears red the LPE or Alpha LPE contains an syntax error. The resulting canvas output will
appear black.
 

http://download.0x1-software.com/LPE_example_scene.mb.zip
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Render Settings Output tab to add LPE
 

Note:
 

•  LPE for Iray Photoreal and Iray Interactive have the same syntax.
 
•  When adding a LPE to Iray Photoreal this LPE will not be used by default by Iray
Interactive when switching render modes and vice versa.
 
•  LPE can vary when using different Render Layers when Create Layer Override is set.

17.2 Image naming when using LPE
 

By default the expression for a canvas will be represented in the file name like this: filename_LPE➤.ext. If you
want to give the resulting image a meaningful name, you can use the following syntax in the LPE field of the
Render Settings: meaningfulName:LPE. The resulting file name will be filename_meaningfulName.ext
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17.3 Predefined LPE
 
In the Render Settings Output tab you find pre-defined LPEs Emission, Diffuse, Glossy, Specular and
Environment. These LPEs create color canvases ( in Maya term Render Passes ) containing the different lighting
effects for all lights in the scene.
 
The default LPEs are "shortcuts" for the following LPEs:
 
Default LPE Emission = [^Le]E
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Default LPE Emission [^Le]E
 

 
Default LPE Diffuse = L.*DE
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Default LPE Diffuse L.*DE
 
 

Default LPE Glossy = L.*GE
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Default LPE Glossy L.*GE
 
 
 

Default LPE Specular = L.*SE
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Default LPE Specular L.*SE
 
 

Default LPE Environment = LeE
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Default LPE Enviornment LeE

17.4 LPE for specific light types
 
In the next step the goal is to separate the light coming from the environment (ifmHosekSkylight and/or
ifmImageBasedlighting) and the light emitting plane in the ceiling.
 
These are the LPEs to separate the environment lighting:
 
 
Environment lighting alone = Le.*E
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Environment lighting alone: Le.*E
 
 

Environment lighting alone without the light emission of environment lighting itself = Le.+E
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Environment lighting alone without the light emission of environment lighting itself =  Le.+E
 

To get the lighting from the light emitting objects, it is necessary to add a handle name to all involved light
emitting objects. This handle name must be set in the Iray section of the Attribute Editor. The LPE to adress
objects with a handle name is <L'handlename'>.*E
 
Note:

•  The handle name in the Attribute and the name used in the LPE must have exact the
same notation.
•   
•  The handle name must enclosed in single quotes (')
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Light only from a light emitting object  =  <L'handlename'>.*E
 
 

When the lighting only from a light emitting object without the object itself is needed use the following LPE =
<L'handlename'>.+E
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Light only from a light emitting object without the object itself = <L'handlename'>.+E

17.5 LPE to get diffuse, glossy and specular for specific light types
 
The basic LPE to split the beauty in its diffuse, glossy and specular parts is similar to the LPE in the chapter 16.4.
 
To get the diffuse component of the environment lighting (all ifmImageBasedLighting, ifmHosekSkylight nodes
and the default Directional Light) use the LPE Le.*DE
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Diffuse component defined by environment lighting = Le.*DE
 

 
To get the glossy component of the environment lighting (all ifmImageBasedLighting and ifmHosekSkylight
nodes) use the LPE Le.*GE
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Diffuse component defined by environment lighting = Le.*GE
 
 

To get the specular component of the environment lighting (all ifmImageBasedLighting and ifmHosekSkylight
nodes) use the LPE Le.*SE
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Specular component defined by environment lighting =  Le.*SE
 
 

To get the diffuse component of light emitting geometry or the default Maya lights use the following LPE:
<L'handlename'>.*DE
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Diffuse component defined by light emitting geometry = <L'handlename'>.*DE
 
 

To get the glossy component of light emitting geometry or the default Maya lights use the following LPE:
<L'handlename'>.*GE
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Glossy component defined by light emitting geometry = <L'handlename'>.*GE
 
 

To get the specular component of light emitting geometry or the default Maya lights use the following LPE:
<L'handlename'>.*SE
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Specular component defined by light emitting geometry = <L'handlename'>.*SE

17.6 LPE to create object alpha masks
 
To get correct alpha masks for specific objects the Alpha LPE can be used. All objects with an identical handle
name will be written into the applied Alpha LPE.
 
Use this Alpha LPE to get the alphg mask of all objects using the same handle name:
E([^'handleName'] .*)? L?
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Alpha LPE for a specific object = E([^'handleName'] .*)? L?

17.7 LPE to create passes for caustics, direct and indirect light
 
In some situations you want to get separate passes for caustics, direct or indirect light only.
 
Use this LPE to get only the caustic lighting effect = L.*SDE
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Caustics only = L.*SDE
 
 

Use this LPE to get only the contribution of the direct lighting effect = L.?E
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Direct light contribution only = L.?E
 
 

Use this LPE to get only the contribution of the indirect lighting effect =  L.{2,}E
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Indirect light contribution only = L.{2,}E
 
 

18 Special commands
 
 

18.1 ifmSpecial
 
When rendering a scene it may happen that you get the following error message in the Maya Output Window:
 
rend warn : Problematic geometry found in object AMPPDGCGAAAAAAAAICBAAAAAAAAA
 
Usually you can ignore this message because the scene renders without a problem. But if you need to know
which geometry is declared as problematic you need to translate the Iray database name back to the name given
in Maya. This can be done using the Mel command ifmSpecial.
 
ifmSpecial has two options:
 

-on StringFromMayaOutputWindow
Prints the original name given in Maya in the Script Editor

 
-s StringFromMayaOutputWindow

Selects the object directly
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Note:
The Iray database names are different after a Maya restart, [File ➤ New] or reopening a
scene.
 
 

Make sure that you are in the Mel-section of the Script Editor. To figure out which object is declared as
problematic type:
ifmSpecial -on AMPPDGCGAAAAAAAAICBAAAAAAAAA
 
The output in the Script Editor should look something like this
//
tube_srf_5Shape //
 
 
To select the object directly in Maya type:
ifmSpecial -s AMPPDGCGAAAAAAAAICBAAAAAAAAA

19 RealityServer export
 

Export dialog box for the RealityServer export.
 
RealityServer is a software development platform for integrating Cloud Based Photorealistic 3D Rendering in
any application. It provides Web services and API frameworks that developers can utilise to easily integrate 3D
rendering in any web based or desktop application. RealityServer runs as a server, much like a standard Web
server like Apache or Microsoft IIS, it accepts requests and responds with streams of 3D rendered imagery.
RealityServer is provided for developers to install either on their own servers or on those of popular Cloud
providers. Read more about RealityServer at https://www.migenius.com
 

Because RealityServer is built directly on NVIDIA® Iray® Iray for Maya 2.2 can be used to create content for
RealityServer. Use the RealityServer export option to get content from Iray for Maya 2.2 to RealityServer. The
output format of the RealityServer export is mi.
 
Use the Maya main menu File -> Export or File -> Export selection to export the scene or selected objects to
Reality Server.
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19.1 General options section
 

General Options window to create Iray for Maya 2.2 material tools
 
The General Option section is the same as for every other export format provided by Maya. It has the same
behaviour for all selected formats.

19.2 File Type Secific Options section
 
 

File Type Specific Options section when RealityServer export is selected
 

Name Style
This option defines how every object name is exported.
 
Unique: Every object has a unique name that has nothing to do with the naming in Maya. This
naming will change each time Maya was restarted. The naming looks something like this: object
"$AJMAKNPKAAAAAAAAICBAAAAAAAAAOHPCNPKKGO"
 
Partial: Exports the name as is and cuts all elements of the name not necessary to identify the object.
The naming looks something like this: object "$group4|group2|pSphere|pSphereShapeGO"
 
Full: Exports the full name path to identify the object. The naming looks something like this: object "$|
main|group4|group2|pSphere|pSphereShapeGO"

 
Binary Data

Some data is written in binary form.
 
Renderer

The rendering options of the chosen renderer are exported.
 

Main Camera
Select the camera to be rendered.

.

20 MDL export
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MDL in the general Maya expor
 

 
Use File -> Export or File -> Export all... to export a shading network build with Iray for Maya 2.2  to MDL. Select
one or more materials e.g. in the HyperShade and choose Export -> MDL Module. A file browser pops up and
lets you save the material network as a MDL preset. This preset can be load into other rendering software that
supports and uses MDL materials.
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